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1 欢迎使用

感谢您购买 HP Photosmart D7100 series 打印机！使用该新款照片打印机，您
可以打印精美的照片、将照片保存到计算机并创建有趣简捷的项目（使用或不使
用计算机均可）。

本手册主要介绍如何在不连接计算机的情况下进行打印。要了解如何从计算机进
行打印，请安装打印机软件并查看电子版帮助。有关将计算机与打印机配合使用
的概述，请参阅从计算机打印。有关安装软件的信息，请参阅“快速入门”手
册。

家庭用户可以了解如何进行以下操作：

● 从打印机或计算机打印无边界照片
● 选择照片布局
● 将彩色照片转换为黑白照片或应用彩色效果（例如，棕褐色或古董色）

本打印机附有下列文档：

● 快速入门手册：“快速入门手册”介绍了如何安装打印机和打印机软件并打
印首张照片。

● 使用手册：“使用手册”是您正在阅读的这本手册。该手册说明了此款打印
机的基本功能，以及如何在不连接计算机的情况下使用打印机，并包含硬件
疑难排解信息。

● 屏幕帮助：HP Photosmart 屏幕帮助说明如何与计算机一起使用打印机，并
包含软件疑难排解信息。

特殊功能
新的功能和介质使您能够比以前更轻松地制作高质量的照片：

● 使用新的 HP 高级照片纸（在有些国家/地区也称为 HP 照片纸）时，打印机
中的特殊传感器会检测纸张背面的标记，然后自动选择最佳的打印设置。有
关这种新型纸张的详细信息，请参阅选择合适的纸张。

● HP Real Life 技术可以让您轻松获得更佳照片。用于增强阴影中细节的“自
动消除红眼”和“适应性照明”只是所包含的众多技术的一部分。您可以从
控制面板和打印机软件浏览众多编辑和增强选项。要从控制面板访问这些功
能，请参阅提高照片质量。要了解如何在软件中查找这些功能，请参阅
HP Real Life 技术功能。

访问 HP Photosmart 屏幕帮助
在计算机上安装 HP Photosmart 软件后，就可以查看 HP Photosmart 屏幕帮
助：

● Windows 计算机：在“开始”菜单中选择“程序”（在 Windows XP 中选
择“所有程序”）> “HP” > “HP Photosmart D7100 series” >
“Photosmart 帮助”。

● Macintosh：从 Finder 的“帮助”菜单中选择“Mac 帮助”。从帮助查看
器的“库”菜单，选择“HP Photosmart Mac 帮助”。
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打印机部件

打印机前部

1 开/关机：按此按钮可打开打印机。

2 顶盖：提起该顶盖可检修墨盒并清除卡纸。要提起顶盖，请握住 HP 徽标下的顶盖
然后向上拉。

3 打印机屏幕：此屏幕可用于查看照片、菜单和信息。

4 出纸盒：该纸盒用于接住打印件。提起该纸盒即可使用照片纸盒。

5 主纸盒：拉出该纸盒可以打印面朝下装入普通纸、投影胶片、信封或其他介质。

6 照片纸盒：提起出纸盒，拉出照片纸盒，然后打印面朝下装入不超过 10 x 15 厘米
（4 x 6 英寸）的小型纸张。纸张可以带裁边或不带裁边。

7 存储卡插槽：在这里插入存储卡。有关支持的存储卡列表，请参阅插入存储卡。

8 相机端口：连接 PictBridge  数码相机、可选的 HP Bluetooth  无线打印机适配器
或 iPod。

打印机后部

1 电源线接口：使用此端口可连接打印机附带的电源线。

2 USB 端口：使用此端口可将打印机连接到计算机。

3 后检修门：取下此门可清除卡纸，或安装可选的“HP 自动双面打印附件”。请参
阅可选附件。

第 1 章
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主纸盒和出纸盒

1 纸张宽度导轨：调整此导轨可使其紧靠主纸盒中纸张的边缘。

2 出纸盒：该纸盒用于接住打印件。提起该纸盒即可使用照片纸盒。

3 出纸盒延长板：将其向外拉出展开出纸盒以接住打印件。

4 主纸盒：将此纸盒拉出以放入普通纸、投影胶片、信封或其他介质，并使打印面朝
下。

5 主纸盒手柄：将其向外拉出以展开主纸盒。

6 纸张长度导板：调整此导板，使其紧靠主纸盒中纸张的末端。

照片纸盒

1 纸张宽度导轨：调整此导轨可使其紧靠照片纸盒中纸张的边缘。

2 纸张长度导板：调整此导板可使其紧靠照片纸盒中纸张的末端。

3 照片纸盒手柄：将其向外拉出以展开照片纸盒。
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控制面板

1 开/关机：打开打印机电源或将其切换到省电模式。

2 后退：按一次后退一屏。

3 首页：按下可返回到首页屏幕。

4 导航箭头：调整裁剪框、导航菜单选项，并控制视频剪辑的播放。

5 OK：选择突出显示的项目、菜单或对话框选项，以及在播放过程中播放/暂停视频
剪辑。

6 打印预览：预览选定的照片。

7 打印：从插入的存储卡，或连接到前部相机端口的相机打印选定的照片。

8 取消：停止打印作业。

9 旋转：旋转照片或裁剪框。

10 缩放 (+)(-)：放大或缩小照片或裁剪框。以正常的放大比例查看照片时，您还可以
按下“缩放”(-) 一次查看四张照片。

11 照片修补：自动增强所有打印的照片并应用亮度、对比度及焦距调节和红眼消除
功能。

指示灯

1 开/关机指示灯：如果已打开打印机，该指示呈蓝色常亮，否则该指示灯熄灭。

2 警示灯：出现错误时闪烁。请查看打印机屏幕以了解错误的相关说明或信息。有关
详细信息，请参阅“警示灯”亮起。

3 打印指示灯：打印机电源打开并准备好打印时呈蓝色常亮，在打印或忙于自我维护
时呈蓝色闪烁。

4 照片修补指示灯：“照片修补”功能打开时呈蓝色常亮。

5 存储卡指示灯：插入存储卡后，该指示灯呈蓝色常亮；打印机访问存储卡时，该指
示灯闪烁；如果未插入存储卡或插入多个存储卡，则该指示灯熄灭。请查看打印机
屏幕以获取相关说明。

第 1 章
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可选附件
有几种可选附件可增加打印机的便携性，以便您随时随地进行打印。这些附件的
外观可能与手册中的图示有所不同。

要购买耗材，请访问：

● www.hpshopping.com（美国）
● www.hp.com/go/supplies（欧洲）
● www.hp.com/jp/supply_inkjet（日本）
● www.hp.com/paper（亚太地区）

附件名称 说明

HP 自动双面打印附件

此附件可自动翻转每一页进行双面打
印。因此，您可以节省成本（双面打
印可减少纸张消耗）和时间（不需要
取出纸张又放进去在背面打印），而
且使大文档更易于管理。

此附件并非在所有国家/地区都提供。

HP Bluetooth  无线打印机适配器

1 将 Bluetooth 适配器插入前面的相
机端口

必须将 HP Bluetooth  无线打印机适
配器插入打印机前面的相机端口。通
过此适配器您可以使用 Bluetooth 无线
技术，从众多具备 Bluetooth 的设备打
印，包括数码相机、可拍照手机和
PDA。
有关使用这些附件进行打印的详细信
息，请访问 www.hp.com/go/
bluetooth。

打印机菜单
按首页按钮以访问首页屏幕。您可以从首页屏幕访问所有功能并设置菜单。

HP Photosmart D7100 series 使用手册 11
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查看与打印

向导：按照向导说明来完成打印过程。该向导也可以用于提高照片质量和应用高
级照片效果，例如，亮度和颜色效果。

4×6：用于打印 4×6 英寸（10 × 15 厘米）的照片。

放大：使用放大功能打印不同尺寸的照片。

打印全部：选择此项可以打印插入打印机的存储卡上的所有照片。

其他打印项目：使用其他项目可以打印全景照片、HP CD/DVD 盘面、皮夹打印
件和护照照片。

– 全景打印件：选择此项可以打开或关闭（默认）全景打印。选择打开可以使
用 3:1 宽高比打印所有选定照片；在打印前放入 10 x 30 厘米（4 x 12 英
寸）的纸张。

– HP CD/DVD 盘面：选择此项可以为 CD/DVD 打印标签。
– 皮夹打印件：使用此项可以打印皮夹大小的照片。
– 护照照片：选择此项可以打印护照照片。

保存

选择保存将选定图像保存到已经连接的计算机。

共享

使用共享通过 HP Photosmart 共享选择和共享照片。

设置

● 工具：使用下列工具可以显示墨水标尺、调整打印质量、打印样本页、打印
测试页以及清洁和校准墨盒。

– 显示墨水标尺：用于在首页屏幕启用供墨标尺。
– 打印样本页：选择此项可以打印样本页，它有助于检查打印机的打印质

量。此功能并非在所有打印机型号上都可以使用。
– 打印测试页：选择此项可以打印包含打印机相关信息的测试页，它有助

于问题的疑难排解。
– 清洁打印头：当打印件上出现白色线条或条纹时，选择此项可以清洁打

印头。完成清洁后，打印机将打印自检报告。如果报告显示打印质量问
题，可以选择重新清洁打印头。

– 校准打印机：当打印件上出现白色线条或条纹时，选择此项可以校准打
印机。

● Bluetooth
– “设备地址”：有些具有 Bluetooth 无线技术的设备需要您输入它们要寻

找的设备地址。此菜单选项会显示打印机地址。
– “设备名称”：您可以选择一个打印机名称，以便在其他具有 Bluetooth

无线技术的设备寻找打印机时显示。
– “密钥”：当打印机的 Bluetooth “安全等级”设置为“高”时，您必须

输入密钥才可让其他 Bluetooth 设备使用该打印机。默认密钥为 0000。
– “可见性”：选择“全部可见”（默认）或“不可见”。将“可见

性”设置为“不可见”时，只有那些知道打印机地址的设备才可以在该
打印机上打印。
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– “安全等级”：选择“低”（默认）或“高”。如果设置为“低”，则
具备 Bluetooth 无线技术的其他设备用户无需输入打印机密钥。设置
为“高”则需要具备 Bluetooth 无线技术的其他设备用户输入打印机密
钥。

– “重置 Bluetooth 选项”：选择此项可以将 Bluetooth 菜单中的所有项
目重置为默认值。

● 帮助菜单：使用帮助菜单获取使用打印机的相关说明。

– 墨盒：选择此项可以查看如何安装墨盒的动画演示。
– 在主纸盒中放入纸张：选择此项可以阅读有关在主纸盒中放入纸张的说

明。
– 在照片纸盒中放入纸张：选择此项可以阅读有关在照片纸盒中放入纸张

的说明。
– 卡纸：选择此项可以查看如何清除卡纸的动画演示。
– 相机连接：选择此项可以阅读有关如何将 PictBridge 相机连接到打印机

的说明。
● 首选项

– 4 × 6 的打印纸张尺寸：选择打印之前询问可以在每次打印时选择纸张
类型和尺寸（默认）。

– 打印质量：选择最佳（默认）或正常的打印质量。
– 纸张类型：选择自动（默认），则打印机将自动检测纸张类型和尺寸。
– 日期戳：使用此项可以在打印出来的照片上添加日期和/或时间。
– 彩色空间：选择彩色空间。自动选择的默认设置指定打印机使用 Adobe

RGB 彩色空间（如果有）。如果没有 Adobe RGB，则打印机默认为
sRGB。

– PictBridge 纸盒选择：用于选择通过 PictBridge 连接打印时的默认纸盒。
– 视频增强：选择打开（默认）或关闭。选择打开时，从视频剪辑打印的

照片的质量将会获得改进。
– “恢复厂商默认设置”：除选择语言和选择国家/地区（在“首选项”菜

单中的“语言”项下）以及 Bluetooth 设置（在打印机主菜单中的
“Bluetooth” 项下）外，恢复所有菜单项的厂商默认设置。此设置不影
响 HP Instant 共享或网络默认值。
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2 准备打印

本节包括以下主题：

● 装入纸张
● 插入墨盒
● 插入存储卡

装入纸张
了解如何为打印作业选择正确的纸张，以及如何将其放入进纸盒以备打印。

选择合适的纸张

使用 HP 高级照片纸。这种纸张专门用于打印机上的墨水，可以生成优质照片。

要获得可用的 HP 设计的照片纸列表，或是要购买耗材，请访问：

● www.hpshopping.com（美国）
● www.hp.com/eur/hpoptions（欧洲）
● www.hp.com/jp/supply_inkjet（日本）
● www.hp.com/paper（亚太地区）

打印机的默认设置为在 HP 高级照片纸上打印最佳质量的照片。如果用其他类型
的纸张打印，请确保在打印机菜单中更改纸张类型。请参阅打印机菜单。

装入纸张提示

放入纸张提示：

● 打印面朝下装入纸张。
● 您可以在各种尺寸的纸张上打印照片和文档，尺寸介于 8 x 13 厘米（3 x 5

英寸）到 22 x 61 厘米（8.5 x 24 英寸）之间。可以使用带或不带裁边的
10 x 15 厘米（4 x 6 英寸）的照片纸。

● 在装入纸张前，请拉出主纸盒并向外滑动纸张宽度导轨和长度导板为纸张留
出空间。装入纸张后，调节导轨和导板使其紧靠纸张的边缘，同时保持纸张
平整。装入纸张后，将主纸盒完全推回到位。

● 在同一纸盒中，一次只能装入同一类型和尺寸的纸张。
● 装入纸张后，请展开出纸盒延伸架并抬高挡块以接住打印页。

在主纸盒中放入纸张

任何支持的照片或普通纸介质

1. 展开主纸盒。
2. 将纸张宽度导轨和长度导板滑至其最外侧。
3. 打印面朝下装入纸张。确保纸叠在纸张长度导板的突块下面有充足的空间。
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1 纸张宽度导轨

2 纸张长度导板

4. 向内调整纸张宽度导轨和长度导板直至其停在纸张的边缘。
5. 将主纸盒完全推入到位。

1 将主纸盒完全推入到位

在照片纸盒中放入纸张

使用不超过 10 x 15 厘米（4 x 6 英寸）带或不带裁边的照片纸、Hagaki 卡、A6
卡和 L 尺寸卡。

1. 提起出纸盒并展开照片纸盒。
2. 向外调节纸张宽度导轨和长度导板为纸张留出空间。

1 出纸盒

2 纸张宽度导轨

3 纸张长度导板

3. 将纸张打印面朝下装入照片纸盒中，最多 20 张。如果使用带裁边的纸张，
请在放入纸张时让裁边朝外。

4. 向内调整纸张宽度导轨和长度导板直至其停在纸张的边缘。确保纸叠在纸张
长度导板的突块下面有充足的空间。

5. 推入照片纸盒。
6. 合上出纸盒。
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1 纸张宽度导轨

2 纸张长度导板

3 照片纸盒手柄

插入墨盒
首次安装和使用 HP Photosmart 时，请确保安装打印机随附的墨盒。这些墨盒
中的墨水配方独特，可与打印头组件中的墨水混合使用。

购买替换墨盒

购买替换墨盒时，请参考本手册封底列出的墨盒编号。墨盒编号会因国家/地区
而异。

注意 如果您已使用过几次打印机，并且已安装 HP Photosmart 打印机软
件，您也可以在打印机软件中找到墨盒编号。Windows 用户：右键单击
Windows 任务栏中的“HP Digital Imaging Monitor”图标，然后选
择“启动/显示 HP 解决方案中心”。选择“设置”、“打印设置”，然
后选择“打印机工具箱”。单击“估计墨水量”选项卡，然后单击“墨盒
详细信息”。要订购墨盒，请单击“在线购物”。Mac 用户：在 Dock 中
点按“HP Photosmart Studio”。在 HP Photosmart Studio 工具栏中点
按“设备”。从“信息和设置”弹出菜单中，选择“维护打印机”，然后
点按“启动实用程序”。在“配置设置”列表中，点按“耗材信息”。
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墨盒提示

HP Vivera 墨水能够生成逼真的照片效果并提供出色的防褪色功能，生成的色彩
鲜明而且更为持久！HP Vivera 墨水配方独特，而且对质量、纯度和防褪色功能
进行了科学测试。

为获得最佳打印质量，HP 建议在盒子上标记的安装期限之前安装所有零售墨
盒。

为获得最佳打印效果，HP 建议您仅使用原装 HP 墨盒。原装 HP 墨盒专门为 HP
打印机所设计并经过科学测试，可帮助您随时轻松获得卓越的打印效果。

注意 HP 无法担保非 HP 墨水的质量和可靠性。由于使用非 HP 墨水导
致的打印机故障或损坏不在保修范围之内。

墨盒

1 请勿将异物插入这些孔中

小心 防止墨水渗漏或溢出：搬运打印机时将墨盒保持在安装位置，并避
免让用过的墨盒留在打印机外过长时间。

墨盒保修信息

HP 墨盒保修条款适用于在其专用 HP 打印设备上使用的产品。该保修条款不适
用于经重新灌注、改装、翻新、使用不当或任意损坏的 HP 墨水产品。

在保修期之内，只要 HP 墨水未用完而且没有过保修期的产品均适用于保修条
款。可以在产品上找到以 YYYY/MM/DD（年/月/日）格式表示的保修截止日
期，如图所示：

有关“HP 有限保修声明”的副本，请参阅 HP 保修条款。
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插入或更换墨盒

1. 确保电源已打开，然后提起顶盖。确保已从打印机内部取出所有包装材料。

2. 按住墨盒插槽下方的灰色突块，放开打印机内的灰色卡销，然后提起卡销。
墨盒区采用了颜色编码以便参照。抬起相应颜色下方的卡销以插入或更换墨
盒。墨盒的颜色从左到右分别为黑色、黄色、浅青色、青色、浅品红色及品
红色。

1 黑色墨盒的卡销

2 彩色墨盒区

3. 如果要更换墨盒，请将墨盒向外拉，使其脱离墨盒槽。

回收旧墨盒。HP 喷墨耗材回收计划覆盖许多国家/地区，免费为您回收用过
的墨盒。有关详细信息，请访问 www.hp.com/hpinfo/globalcitizenship/
environment/recycle/inkjet.html。

4. 从包装盒中取出新墨盒，然后握住其手柄，将墨盒滑入空插槽中。
确保插入墨盒的插槽上的图标形状和颜色与新墨盒上的一致。插入墨盒时，
铜色触点应该面向打印机。
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注意 首次安装和使用打印机时，请确保安装打印机随附的墨盒。这
些墨盒中的墨水配方独特，可与打印头组件中的墨水混合使用。

5. 向下按压灰色卡锁直到它卡住。

6. 对每个需要更换的墨盒重复步骤 2 至 5。
必须安装所有的六个墨盒。如果缺少一个墨盒，打印机将无法工作。

7. 合上顶盖。

插入存储卡
使用数码相机拍完照片后，可以从相机中取出存储卡并将其插入打印机中， 以
查看并打印照片。打印机可读取下列类型的存储卡：CompactFlash 、Memory
Sticks、Microdrive 、MultiMediaCard 、Secure Digital ， 以及 xD-Picture
Card 。

小心 使用任何其他类型的存储卡都可能会损坏存储卡和打印机。

要想了解将照片从数码相机传输到打印机的其他方法，请参见连接到其他设备。

支持的文件格式    
打印机可直接从存储卡中识别和打印以下格式的文件：JPEG、未压缩 TIFF、
Motion JPEG AVI、Motion-JPEG Quicktime 和 MPEG-1。如果数码相机将照片
和视频剪辑保存为其他文件格式，请将这些文件保存到计算机并使用软件程序进
行打印。有关详细信息，请参阅电子版帮助。
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插入存储卡

存储卡插槽

1 xD-Picture Card
2 Memory Stick
3 CompactFlash I 型和 II 型、Microdrive
4 Secure Digital、MultiMediaCard（MMC）

存储卡类型

在下表中找到您的存储卡，并按照说明将其插入打印机中。

原则：

● 一次只插入一张存储卡。
● 将存储卡轻轻推入打印机，直到推不动为止。存储卡插槽只允许卡的一部分

插入打印机；请勿试图用力将存储卡完全插入打印机。
● 正确插入存储卡后，存储卡指示灯闪烁，然后保持绿色点亮。

小心 1 以其他任何方式插入存储卡都可能会损坏存储卡和打印机。

小心 2 当存储卡指示灯呈绿色闪烁时请勿抽出存储卡。有关详细信息，
请参阅取出存储卡。

存储卡 如何插入存储卡

CompactFlash ● 正面标签朝上，如果标签上有箭头，箭头应指向打印机
● 将具有金属针孔的一端先插入打印机
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存储卡 如何插入存储卡

Memory Stick ● 斜角位于左侧
● 金属触点朝下
● 如果使用 Memory Stick Duo 或 Memory Stick PRO Duo 存

储卡，请在将卡插入打印机前先连接存储卡随附的适配器

Microdrive ● 正面标签朝上，如果标签上有箭头，箭头应指向打印机
● 将具有金属针孔的一端先插入打印机

MultiMediaCard ● 斜角位于右侧
● 金属触点朝下

Secure Digital ● 斜角位于右侧
● 金属触点朝下

xD-Picture Card ● 将存储卡呈弧形的一边向外
● 金属触点朝下

取出存储卡

等存储卡指示灯停止闪烁后，轻轻将存储卡从打印机中抽出。

小心 请勿在存储卡指示灯闪烁时取出存储卡。闪烁的指示灯表示打印机
正在访问存储卡。取出正被访问的存储卡可能会损坏打印机和存储卡，或
毁坏存储卡上的信息。

第 2 章
（续）

22 HP Photosmart D7100 series



3 在不使用计算机的情况下打印照片

通过 HP Photosmart D7100 series 打印机，不用打开计算机即可选取、增强和
打印照片。使用“快速入门手册”中的说明安装好打印机后，可以在打印机中插
入存储卡并使用打印机控制面板上的按钮打印照片。

还可以直接从数码相机打印照片。有关详细信息，请参阅从数码相机打印照片。

打印照片
您可以无需计算机而通过下列各种方式打印照片：

● 将存有照片的存储卡插入打印机的存储卡插槽中
● 将 PictBridge 数码相机连接到打印机前面的相机端口
● 安装可选的 HP Bluetooth  无线打印机适配器，然后利用 Bluetooth 无线技

术从数码相机打印

从存储卡打印照片

您可以从插入打印机的存储卡打印照片，也可以使用打印机的控制面板查看、选
择、增强并打印照片。还可以从存储卡直接打印相机选定的照片 — 使用数码相
机将照片标记为打印。

从存储卡打印方便快捷，而且不会消耗相机电池电量。

打印一张或多张照片

开始打印之前，请确保存储卡已插入打印机中，而且已在要使用的纸盒中放入正
确的纸张。

1. 选择查看与打印，然后按 OK。
2. 选择 4×6 或放大以选择需要的照片尺寸，然后按 OK。
3. 选择需要的照片尺寸，然后按 OK。
4. 选择布局，然后按 OK。
5. 使用方向键滚动浏览现有的照片。
6. 按 OK 以选择一幅或多幅图像。

– 按缩放 - 可以在打印机屏幕上一次查看多达 9 幅图像。
– 按向上箭头可以增加所选图像的打印数量。

7. 按打印以打印选定的照片。

检查照片纸盒指示灯以确认是否选择了正确的纸盒 — 主纸盒指示灯应该熄灭而
照片纸盒指示灯则应该亮起。

打印存储卡上的所有照片

开始打印之前，请确保存储卡已插入打印机中，并且已在要使用的纸盒中放入正
确的纸张。

1. 选择查看与打印，然后按 OK。
2. 选择打印全部。
3. 选择需要的打印尺寸，然后按 OK。
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➔ 选择布局，然后按 OK。
4. 选择立即打印，然后按 OK。

打印存储卡上相机选定的照片

使用数码相机选择要打印的照片时，相机会创建一个数字打印指令格式
（DPOF）文件来标识选定的照片。打印机可以直接从存储卡读取 DPOF 1.0 和
1.1 文件。

1. 使用数码相机选择要打印的照片。有关详细信息，请参阅相机随附的文档。
2. 如果使用相机选择默认作为照片布局，请选择布局以选择照片布局。

如果用相机选择默认之外的其他照片布局，将使用相机选定的布局打印照
片，无论打印机的设置如何。

3. 放入所需纸张。
4. 从数码相机中取出存储卡，然后将其插入打印机。
5. 当打印机屏幕上出现一则信息询问您是否要打印相机选定的照片时，请按

OK。
开始打印相机选定的照片。

如果打印机无法找到或读取存储卡上相机选定的所有照片，它将打印那些可以读
取的照片。

打印完后，打印机将删除 DPOF 文件并取消照片的标记。

使用向导进行打印

打印向导提供了对照片进行选择、调整尺寸、编辑和打印的详细说明。

注意 向导可用于提高照片质量和应用高级效果，例如，亮度和颜色效
果。

1. 选择查看与打印，然后按 OK。
2. 选择向导，然后按 OK。
3. 按照提示打印所需照片。

从视频剪辑打印照片

您可以在打印机屏幕上查看视频剪辑，并选择打印单个帧。

第一次插入包含视频剪辑的存储卡时，打印机在屏幕上使用视频剪辑的第一帧来
表示该剪辑。

打印机可以识别下列格式的视频剪辑：

● Motion-JPEG AVI
● Motion-JPEG QuickTime
● MPEG-1
打印机将忽略其他任何格式的视频剪辑。

开始打印之前，请确保存储卡已插入打印机中，并且已在要使用的纸盒中装入正
确的纸张。

1. 选择查看与打印，然后按 OK。
2. 要选择所需的照片尺寸，请选择 4×6 或放大，然后按 OK。
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3. 选择所需的纸张尺寸，然后按 OK。
4. 使用左右箭头浏览并选择可用的视频。

注意 视频将在图像中央显示为一个摄像机图标。

5. 按向上箭头播放视频。
6. 要选择某帧进行打印，请按向上箭头暂停视频播放。必须暂停视频以选择要

打印的帧。
7. 按 OK 以选择要打印的帧。
8. 按打印以打印选定的帧。

打印照片索引页

照片索引页可以显示存储卡上多达 2000 张照片的缩略图和索引编号。使用普通
纸代替照片纸可以降低成本。

照片索引可能有几页长。

开始打印之前，请确保存储卡已插入打印机，并且已在要使用的纸盒中装入正确
的纸张。

1. 选择查看与打印，然后按 OK。
2. 选择打印全部，然后按 OK。
3. 选择 8.5×11 的纸张。
4. 选择索引页图标（每页 16 幅图像），然后按 OK。

停止打印

要停止进行中的打印作业，请按取消。

从数码相机打印照片

您可以使用 USB 电缆将 PictBridge 数码相机直接连接到打印机的相机端口来打
印照片。如果数码相机具备 Bluetooth 无线技术，则可以将可选的 HP
Bluetooth  无线打印机适配器插入打印机，然后以无线方式将照片发送到打印
机。

从数码相机打印时，打印机将使用已在相机上选择的设置。有关详细信息，请参
阅相机随附的文档。

具有 Bluetooth 无线技术的数码相机

如果数码相机具有 Bluetooth 无线技术，则可以购买可选的 HP Bluetooth  无线
打印机适配器并通过 Bluetooth 无线连接从相机进行打印。

注意 您还可从其他具有 Bluetooth 无线技术的设备（如 PDA 和相机手
机）进行打印。有关详细信息，请参阅连接到其他设备和 Bluetooth 适配
器随附的文档。

1. 使用显示器上的 Bluetooth 菜单设置打印机的 Bluetooth 选项。有关详细信
息，请参阅设置。

2. 在打印机中放入纸张。
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3. 将 HP Bluetooth  无线打印机适配器插入打印机前面的相机端口。
当适配器准备好接收数据时，适配器上的指示灯会闪烁。

4. 按照数码相机随附文档中的说明将照片发送到打印机。

具有 PictBridge 技术的数码相机

1. 打开 PictBridge 数码相机并选择要打印的照片。
2. 放入纸张。
3. 确保相机处于 PictBridge 模式，然后用相机随附的 USB 电缆将它连接到打

印机前面的相机端口。
打印机识别出 PictBridge 相机后，就会自动打印选定的照片。

从 iPod 打印照片

如果您有可以存储照片的 iPod，则可以将 iPod 连接到打印机并打印照片。

开始前的准备

检查拷贝到 iPod 的图像是否为 JPEG 格式。

注意 iPod 在您所在的国家/地区可能不可用。

将照片导入 iPod
1. 使用 iPod 的专用 Belkin 媒体阅读器，将照片从存储卡拷贝到 iPod。
2. 在 iPod 菜单上选择“照片导入”，以确定 iPod 上是否有照片。照片将显示

为“卷”。

从 iPod 打印照片

1. 用 iPod 随附的 USB 电缆将 iPod 连接到打印机前部的相机端口。在读取照
片时，打印机屏幕将会显示“正在读取设备”几分钟。然后打印机屏幕上将
显示照片。

2. 选择要打印的照片然后按打印。有关选择和打印照片的详细信息，请参阅打
印照片。

照片布局
从“查看与打印”菜单选择所需的打印功能，按 OK，然后选择要用的纸张尺寸
以选定布局。

布局 纸张尺寸（照片尺寸）

每页 1 张，无边框 4 x 6 英寸（4 x 6 英寸）

10 x 15 厘米（10 x 15 厘米）

5 x 7 英寸（5 x 7 英寸）

8.5 x 11 英寸（8.5 x 11 英寸）
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布局 纸张尺寸（照片尺寸）

每页 1 张 3.5 x 5 英寸（3.25 x 4.75 英寸）

4 x 6 英寸（3.75 x 5.75 英寸）

10 x 15 厘米（9.53 x 14.6 厘米）

5 x 7 英寸（4.75 x 6.75 英寸）

8 x 10 英寸（7.75 x 9.75 英寸）

8.5 x 11 英寸（8 x 10 英寸）

A6（9.86 x 14.16 厘米）

A4（20 x 25 厘米）

Hagaki（9.36 x 14.16 厘米）

L（8.25 x 12.06 厘米）

每页 2 张 3.5 x 5 英寸（2.25 x 3.25 英寸）

4 x 6 英寸（2.75 x 3.75 英寸）

5 x 7 英寸（3.25 x 4.75 英寸）

8 x 10 英寸（4.75 x 6.5 英寸）

8.5 x 11 英寸（5 x 7 英寸）

A6（6.92 x 9.86 厘米）

A4（13 x 18 厘米）

Hagaki（6.8 x 9.36 厘米）

L（5.87 x 8.25 厘米）

每页 3 张 3.5 x 5 英寸（1.5 x 2.25 英寸）

4 x 6 英寸（1.75 x 2.625 英寸）

5 x 7 英寸（2.25 x 3.375 英寸）

8 x 10 英寸（3.33 x 5 英寸）

8.5 x 11 英寸（4 x 6 英寸）

A6（4.77 x 7.15 厘米）

A4（10 x 15 厘米）

Hagaki（4.52 x 6.78 厘米）

L（3.96 x 5.94 厘米）

每页 4 张 3.5 x 5 英寸（1.5 x 2.25 英寸）

4 x 6 英寸（1.75 x 2.5 英寸）

（续）
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布局 纸张尺寸（照片尺寸）

5 x 7 英寸（2.2 x 3.25 英寸）

8 x 10 英寸（3.5 x 4.75 英寸）

8.5 x 11 英寸（3.5 x 5 英寸）

A6（4.77 x 6.92 厘米）

A4（9 x 13 厘米）

Hagaki（4.52 x 6.5 厘米）

L（3.96 x 5.7 厘米）

每页 9 张 3.5 x 5 英寸（1 x 1.375 英寸）

4 x 6 英寸（1.125 x 1.5 英寸）

5 x 7 英寸（1.5 x 2 英寸）

8 x 10 英寸（2.25 x 3 英寸）

8.5 x 11 英寸（2.5 x 3.25 英寸） –
皮夹尺寸

A6（3.07 x 4.05 厘米）

A4（6.4 x 8.4 厘米）

Hagaki（2.9 x 3.86 厘米）

L（2.53 x 3.36 厘米）

注意 打印机可能会根据布局旋转照片。

提高照片质量
本款打印机提供了多种增强功能，可提高从存储卡打印的照片质量。这些打印设
置不会改变原始照片。它们只会影响打印过程。

调整亮度不佳的照片

1. 选择查看与打印，然后按 OK。
2. 选择向导，然后按 OK。
3. 按照屏幕说明选择纸张尺寸和照片，然后按 OK 查看菜单。
4. 选择编辑照片，然后按 OK。
5. 选择照片亮度，然后按 OK。
6. 按  和  将照片亮度增加或降低到合适的水平，然后按 OK。

去除照片上的红眼

打开照片修补功能时，将启用自动消除红眼功能。启用“照片修补”功能可以在
选定的照片上应用智能聚焦、适用性照明和红眼消除功能。

➔ 按照片修补以启用照片修补功能。
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调整质量不佳的视频剪辑

该首选项会影响从视频剪辑打印的照片。

提高从视频剪辑打印的照片质量

1. 选择设置，然后按 OK。
2. 使用方向键找到并选择首选项，然后按 OK。
3. 使用方向键找到并选择视频增强，然后按 OK。
4. 选择打开，然后按 OK。

有关从视频剪辑打印照片的信息，请参阅从存储卡打印照片。

使用创意
本款打印机提供了多种工具和效果，使您能够以独特方式处理照片。这些打印设
置不会改变原始照片。它们只会影响打印过程。

添加颜色效果

对打印机进行设置，将应用于照片的颜色选项从彩色（默认）更改为黑白、棕褐
色或古董色。

以棕褐色打印的照片呈棕色色调，看起来像二十世纪早期拍摄的照片。以古董色
打印的照片呈现相同的棕色色调，但加入了苍白的色调，照片给人的感觉像是手
工着色的。

1. 选择查看与打印，然后按 OK。
2. 选择向导，然后按 OK。
3. 按照屏幕说明选择纸张尺寸和照片，然后按 OK。
4. 选择完成选择，然后按 OK。
5. 选择编辑照片，然后按 OK。
6. 选择颜色效果，然后按 OK。
7. 选择所需的颜色效果，然后按 OK。

在打印件上添加日期和时间

您可以在照片正面打印表明照片拍摄时间的标记。该首选项将影响所有打印件。

1. 选择设置，然后按 OK。
2. 使用方向键找到并选择首选项，然后按 OK。
3. 选择日期戳，然后按 OK。
4. 选择下面的一个日期/时间标记选项：

– 日期和时间
– 仅日期
– 关闭

如果使用计算机修改照片并保存所做的修改，最初的日期和时间信息将丢失。您
通过打印机控制面板对照片所作的修改不会影响日期和时间信息。

更改打印质量

您可以更改照片的打印质量设置。“最佳”质量为默认设置，可生成质量最佳的
照片。“正常”质量可节省墨水并提高打印速度。
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更改打印质量：

1. 选择设置，然后按 OK。
2. 选择首选项，然后按 OK。
3. 选择打印质量，然后按 OK。
4. 选择所需的打印质量，然后按 OK。

执行下一个打印作业之后，打印质量将恢复为“最佳”。

裁剪照片

按缩放 + 和 缩放 – 将放大倍数增加或减少 1.25x（1.25 倍）。最大放大倍数
是 5.0x（5 倍）。

1. 选择查看与打印，然后按 OK。
2. 选择 4×6 或放大以选择所需照片尺寸，然后按 OK。
3. 选择所需的纸张尺寸，然后按 OK。
4. 选择要用的照片，然后按 OK。
5. 按 Zoom + 将照片放大倍数增加 1.25x。将显示绿色裁剪框。重复按缩放 +

直到达到要求的放大倍数。（放大后，您可以按缩放 – 返回到原来的尺
寸。）

注意 如果以所选放大倍数打印时打印质量明显下降，裁剪框将从绿
色变为黄色。

6. 在任一放大倍数下，按箭头键可将裁剪框向左、右、上、下方向移动。
7. 当图像的要打印部分位于裁剪框中时，按 OK。

裁剪操作不会改变原始照片。它只会影响打印过程。

打印全景照片

1. 选择查看与打印，然后按 OK。
2. 选择其他项目，然后按 OK。
3. 选择全景打印，然后按 OK。
4. 按照提示放入 10 x 30 厘米（4 x 12 英寸）的介质，然后按 OK。
5. 选择照片，然后按 OK。根据需要在打印之前裁剪照片。裁剪框的宽高比

是 3:1。

注意 以全景模式打印的所有照片都没有边框。
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4 连接

您可以使用此打印机保持与其他设备的连接，并与他人保持联系。

连接到其他设备
该打印机可以通过多种方法连接到计算机或其他设备。不同的连接类型可以完成
不同的工作。

连接类型及所需准备工作 用途...

存储卡

存储卡

兼容型数码相机存储卡

将存储卡插入打印机前方相应的插槽。

● 从存储卡直接打印到打印机。
● 将已插入打印机的存储卡上的照片

保存到计算机，然后在
HP Photosmart Premier 或其他软
件中增强这些照片的效果或管理照
片。有关详细信息，请参阅将照片
保存到计算机和从存储卡打印照
片。

USB
● 一条长度不超过 3 米（10 英尺）

的通用串行总线 (USB) 2.0 全速兼
容电缆。有关使用 USB 电缆连接
打印机的说明，请参阅“快速入
门”小册子。

● 一台可以连接到 Internet 的计算机
（使用 HP Photosmart 共享）。

● 从计算机打印到打印机。请参阅从
计算机打印。

● 将已插入打印机的存储卡上的照片
保存到计算机，然后在
HP Photosmart Premier 或其他软
件中增强这些照片的效果或管理照
片。

● 通过 HP Photosmart 共享共享照
片。

● 从 HP Photosmart 直接打印数码
相机直接打印到打印机。有关详细
信息，请参阅从数码相机打印照片
和相机随附的文档。

PictBridge

PictBridge 标志

从 PictBridge 兼容数码相机直接打印
到打印机。

有关详细信息，请参阅从数码相机打
印照片和相机随附的文档。
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连接类型及所需准备工作 用途...
PictBridge 兼容数码相机和 USB 电缆。

将相机连接到打印机前方的相机端口。

Bluetooth
可选的 HP Bluetooth 无线打印机适配
器。

如果打印机带有或者您单独购买了此
附件，请参阅随附的文档和屏幕帮助
以了解相关说明。

从具有 Bluetooth 无线技术的任何设
备，例如数码相机、可拍照手机或
PDA 等打印到打印机。

如果将可选的 HP Bluetooth 无线打印
机适配器连接到打印机的相机端口，
请确保已根据需要设置了 Bluetooth 打
印机菜单选项。请参阅设置。

iPod
iPod 及其随附的 USB 电缆。将 iPod
连接到打印机前方的相机端口。

从 iPod（存有照片）直接打印到打印
机。有关详细信息，请参阅从 iPod 打
印照片。
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将照片保存到计算机
您可以将插入打印机的任何存储卡上的照片保存到计算机，但首先要在这两个设
备之间建立 USB 连接。

如果使用 Windows 计算机

使用下列一种方法将照片保存到计算机。

● 将存储卡插入打印机中。将在计算机屏幕上打开 HP Photosmart Premier 传
输软件（HP 传输和快速打印），在计算机上为图像指定一个保存位置。有
关详细信息，请参阅屏幕上的 HP Photosmart 软件帮助。

● 将存储卡插入打印机。存储卡将在 Windows 资源管理器中显示为可移动驱
动器。将其打开，然后将卡上的照片拖动到计算机上的任何位置。

如果使用 Macintosh
1. 将存储卡插入打印机。
2. 等待 iPhoto 启动并读取存储卡的内容。

注意 只有将 iPhoto 设为默认应用程序时它才会启动。

3. 点按“导入”将卡上的照片保存到 Macintosh。

注意 存储卡在桌面上也显示为驱动器图标。可以打开它并将卡上的照片
拖动到 Macintosh 上的任何位置。

通过 HP Photosmart 共享连接
在 HP Photosmart 共享中使用电子邮件、在线相册或在线照片冲印服务与亲友
共享照片。必须用 USB 电缆将打印机连接到计算机，该计算机可以访问 Internet
且上面安装了全部 HP 软件。如果要使用“共享”功能，但没有安装或配置要求
的全部软件，则会出现一则信息，提示您完成所需步骤。

使用“共享”功能 (USB) 发送照片（Windows 用户）：

1. 插入存储卡并选择照片。
2. 在计算机屏幕上选择共享，然后按 OK。
3. 按照计算机上的说明与他人共享所选照片。

使用“共享”功能 (USB) 发送照片（Mac 用户）：

1. 打开“HP Photosmart Studio”，然后选择要共享的照片。有关
HP Photosmart Studio 的详细信息，请参阅 HP Photosmart Premier
（Windows 用户）。

2. 在 HP Photosmart Studio 任务栏中点按“共享”。
3. 点按继续并按照计算机上的说明与他人共享所选照片。

有关使用 HP Photosmart 共享的详细信息，请参阅软件的屏幕帮助。
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5 从计算机打印

要从计算机打印，必须安装打印机软件。软件安装过程中，HP Photosmart
Premier（Windows 完全安装用户）、HP Photosmart Essential（Windows 快
速安装用户）或 HP Photosmart Studio (Mac) 将安装到计算机上，您可以管
理、共享、编辑并打印照片。

有关安装软件的详细信息，请参阅“快速入门手册”。定期更新软件以确保拥有
最新的功能和改进；有关说明，请参阅更新软件。

要处理照片，请将照片传输到与打印机连接的计算机。请参阅将照片保存到计算
机。

注意 Windows 用户：HP Photosmart Premier 只能在具有速度不低于
Intel  Pentium  III 处理器的计算机上使用。

使用打印机软件中的创意选项
请阅读以下提示，了解如何打开和使用 HP Photosmart Premier、HP Photosmart
Essential、HP Photosmart Studio (Mac) 和 HP Photosmart 共享。

HP Photosmart Premier（Windows 用户）

HP Photosmart Premier 是一个简单易用的软件程序，除了基本的照片编辑和打
印外，它还为您提供一切所需功能使您在处理照片时获得无穷乐趣。您还可以通
过该软件访问 HP Photosmart 共享以便轻松共享照片。

打开 HP Photosmart Premier
➔ 双击桌面上的“HP Photosmart Premier”图标。如果需要帮助，请参阅

HP Photosmart Premier 中的软件帮助。

浏览 HP Photosmart Premier 的众多功能：

● 查看 - 以多种尺寸和方式查看照片，轻松组织和管理照片。
● 编辑 - 裁剪照片并修正有红眼的照片，自动调整和增强不同尺寸和多种布局

的照片。
● 打印 - 打印不同尺寸和多种布局的照片。
● 共享 - 使用 HP Photosmart 共享可以无需大容量附件即可给亲友发送照片，

是一种更好的电子邮件方式。
● 创建 - 轻松创建相册页、卡片、日历、全景照片、CD 标签等。
● 备份 - 备份照片副本以进行存放和保存。

HP Photosmart Essential（Windows 用户）

HP Photosmart Essential 是一个简单易用的软件程序，它为您提供基本的照片
编辑和打印功能。该软件还可以访问 HP Photosmart 共享以便轻松共享照片。
HP Photosmart Essential 仅适用于 Windows 用户。
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打开 HP Photosmart Essential
➔ 双击桌面上的“HP Photosmart Essential”图标。如果需要帮助，请参阅

HP Photosmart Essential 中的软件帮助。

浏览 HP Photosmart Essential 的众多功能：

● 查看 - 以多种尺寸和方式查看照片，轻松组织和管理照片。
● 编辑 - 裁剪照片并修正有红眼的照片，自动调整和增强照片使之更臻完美。
● 打印 - 打印不同尺寸和多种布局的照片。
● 共享 - 使用 HP Photosmart 共享可以无需大容量附件即可给亲友发送照片，

是一种更好的电子邮件方式。

HP Photosmart Studio（Macintosh 用户）

➔ 点按 Dock 中的“HP Photosmart Studio”图标。

浏览 HP Photosmart Mac 软件的众多功能，从 HP Photosmart Studio 可以访问
该软件：

● 导入 - 从 HP 数码相机导入照片或视频。
● 查看和管理 - 查看、组织和管理照片以及视频。
● 编辑 - 调整和增强图像。
● 幻灯片演示 - 创建照片的在线幻灯片。
● 全景 - 从多幅图像创建单幅全景图像。
● 创建 - 创建相册页、卡片、标签、海报、条幅等。
● 打印 - 以标准尺寸或索引页格式打印照片或视频帧。
● 共享 - 无需大容量的附件即可给亲友发送照片。
● 订购 - 在线订购打印件和礼品。

HP Photosmart 共享

HP Photosmart 共享可以让您无需大容量的电子邮件附件即可将照片发送给亲
友。有关详细信息，请参阅通过 HP Photosmart 共享连接和 HP Photosmart
Premier 或 HP Photosmart Essential 帮助。

打开 HP Photosmart 共享（Windows 用户）

➔ 在 HP Photosmart Premier 或 HP Photosmart Essential 中单击“HP
Photosmart 共享”。

打开 HP Photosmart 共享（Mac 用户）

➔ 在 HP Photosmart Premier 中点按“应用程序”选项卡，然后连按“HP
Photosmart 共享”。

设置打印首选项
打印首选项已有默认设置，但可以根据需要进行更改。从计算机打印时可以设置
特定作业的打印设置。如果您在打印前更改设置，则这些更改只影响当前的打印
作业。在有些 Windows 软件程序中，您需要在“打印”对话框中单击“属
性”或“首选项”以访问高级打印功能。有关打印首选项的详细信息，请参阅电
子版帮助。
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访问打印首选项（Windows 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 更改“打印”对话框各选项卡中的打印首选项，或者单击“属性”或“首选

项”以访问其他打印首选项。

访问打印首选项（Mac 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 通过在“份数和页数”下拉菜单中选择要更改的打印选项来更改“打印”对

话框中的打印首选项。

有关更改打印首选项的详细信息，请参阅电子版帮助。

打开电子版帮助

Windows 用户：

● 在键盘上按 F1。
● 要获得字段级的帮助，请单击“打印”对话框中右上角的“?”。

Mac 用户：

1. 从“Finder”中，选择“帮助” > “Mac 帮助”。
2. 从“库”菜单选择“HP Photosmart Mac 帮助”，然后在“HP Photosmart

Mac 帮助”目录中选择打印机名称。

HP Real Life 技术功能
浏览 HP Real Life 技术软件功能中的众多照片编辑和增强选项。这些功能（例
如自动消除红眼和适应性照明）可以让您轻松打印高质量照片。

共有三种选项：

● “基本”设置可以增强图像，并提高低分辩率图像（例如，从 Internet 下载
的图像）的质量和清晰度。

● “完整”设置用于改善曝光不足、曝光过度、含有暗区、红眼或褪色的图像。
● “关闭”设置可以让您在软件程序（例如 HP Photosmart 软件）中手动编辑

图像。

访问 Real Life 技术功能（Windows 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 单击“纸张/质量”选项卡，然后单击“Real Life 数字摄影”按钮 - 或 - 单

击“属性”或“首选项”按钮，然后单击“Real Life 数字摄影”按钮。

访问 Real Life 技术功能（Mac 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 从“份数和页数”下拉菜单中选择“Real Life 数字摄影”。
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6 保养与维护

本打印机很少需要维护。遵循本章中的各项指示，可延长打印机及打印耗材的使
用寿命，并确保您始终能够打印出高质量的照片。

● 清洁和维护打印机
● 更新软件
● 打印机与墨盒的存放与搬运
● 维护照片纸质量

清洁和维护打印机
使用本节所述的简易方法，保持打印机和墨盒的清洁并进行良好的维护。

清洁打印机外部

1. 关闭打印机，然后从打印机后面断开电源线。
2. 用蘸有少量清水的软布擦拭打印机的外部。

小心 请勿使用任何清洁液，家用清洁剂和洗涤剂会损坏打印机的表面涂
层。请勿清洁打印机内部。防止液体进入打印机内部。请勿润滑支撑打印
头滑动的金属杆。打印头前后移动时发出声响是正常现象。

校准打印机

当自检报告的任何颜色块中显示条纹或白线时，请按照以下步骤操作。

如果校准打印机后仍然存在打印质量问题，请按照保养与维护中的步骤清洁打印
头。如果在校准和清洁后，仍然存在打印质量问题，请与 HP 支持部门联系。

1. 在主纸盒中放入未用过的 Letter 或 A4 尺寸的普通白纸。
2. 选择设置，然后按 OK。
3. 选择工具，然后按 OK。
4. 浏览查找，然后选择校准打印机。

打印机将校准打印头、打印校准页并校准打印机。回收或丢弃校准页。
5. 按 OK。

打印样本页

您可以打印样本页来测试打印机的照片打印质量，并确保已正确放入纸张。

1. 将纸张放入主纸盒。使用普通纸以节约照片纸。
2. 选择设置，然后按 OK。
3. 选择工具，然后按 OK。
4. 选择打印样本页，然后按 OK。
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自动清洁打印头

如果在打印的照片或自检报告的颜色块中发现白色线条或条纹，请按照此步骤清
洁打印头。仅在必要时才清洁打印头，否则会浪费墨水并缩短打印头上墨水喷嘴
的使用寿命。

1. 将纸张放入主纸盒。使用普通纸以节约照片纸。
2. 选择设置，然后按 OK。
3. 选择工具，然后按 OK。
4. 选择清洁打印头，然后按 OK。

如果在清洁打印头后打印质量仍然不佳，请尝试按照校准打印机中的步骤校准打
印机。如果在清洁和校准后仍然存在打印质量问题，请与 HP 支持部门联系。

手动清洁墨盒触点

如果打印机屏幕显示墨盒缺失或损坏信息，请清洁墨盒的铜色触点。

清洁墨盒触点前，请取出墨盒并确认没有物件遮盖墨盒触点或墨盒插槽，然后将
墨盒装回。如果仍然显示墨盒缺失或损坏信息，请清洁墨盒触点。如果清洁墨盒
触点后仍然显示此信息，则需要更换墨盒。取出有问题的墨盒，查看底部的质保
截止日期，日期格式为 YYYY/MMM/DD（年/月/日）。如果在保质期之内，请
与 HP 支持联系以更换墨盒。

清洁墨盒触点：

1. 准备好清洁触点所需的下列物品：

– 蒸馏水、过滤水或瓶装水（自来水中可能包含会损坏墨盒的杂质）

小心 不要使用滚筒清洁器或酒精来清洁墨盒触点。这些物质会
损坏墨盒或 HP Photosmart 打印机。

– 使用干燥的泡沫橡胶拭子、无绒布、或者不会散开或留下纤维的任何柔
软材料。

2. 打开打印机的顶盖。
3. 按压墨盒插槽下方的灰色突块，释放打印机内部的灰色卡销，然后提起卡

销。

小心 不要同时取出多个墨盒，一次仅取出和清洁一个墨盒，请勿将
墨盒放在打印机外面超过 30 分钟。

4. 用水稍微润湿拭子或软布，并挤掉多余的水分。
5. 握住墨盒手柄，然后用拭子或软布只轻轻擦拭铜色触点。
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1 只轻轻擦拭铜色触点

6. 将墨盒放回空的插槽，然后向下按压灰色卡销直到它卡入到位。
7. 如有必要，请重复此步骤清洁其他墨盒。
8. 合上顶盖。

小心 供墨装置可能增压。将异物插入供墨装置会导致墨水喷出并溅到人
员或物品上。

打印自检报告

如果遇到打印问题，请打印自检报告。这份两页式报告（标记为“扩展自检诊断
页”）可以帮助您诊断打印问题，并为您提供在致电 HP 支持部门时需要的有用
信息。您也可以用此报告来检查墨盒中剩余的估计墨水量百分比。

1. 选择设置，然后按 OK。
2. 选择工具，按 OK，然后浏览到“打印测试页”。
3. 选择打印测试页，然后按 OK。

HP Photosmart 将打印含有下列信息的两页式自检报告：

● 产品信息：包括打印机型号、序列号和产品其他信息。
● 版本信息：包括固件版本号，并说明是否安装了 HP 双面打印附件（双面打

印器）。
● 供墨系统信息：显示所安装的每个墨盒的估计墨水量、状态、安装日期，以

及有效日期。
● 打印头组件信息：包括要致电 HP 支持部门时用于诊断的信息。
● 打印头参数：包括要致电 HP 支持部门时用于诊断的信息。
● 打印质量图案：显示六个颜色块，分别代表已安装的六个墨盒。当颜色块中

出现条纹，或缺失颜色块时，请按照保养与维护中的步骤清洁打印头。如果
在清洁打印头后，颜色块仍然显示打印质量问题，请按照校准打印机中的步
骤校准打印机。如果在清洁和校准之后，颜色块仍然显示有打印质量问题，
请与 HP 支持部门联系。

● 历史记录日志：包括要致电 HP 支持部门时用于诊断的信息。

HP Photosmart D7100 series 使用手册 41



自检报告

更新软件
定期下载最新的打印机软件更新程序，以确保软件拥有最新的功能和改进。可以
访问 www.hp.com/support 或使用“HP 软件更新”来下载打印机软件更新程序。

注意 从 HP 网站下载的打印机软件更新不能更新 HP Photosmart Premier
软件。

下载软件 (Windows)

注意 在使用“HP 软件更新”前，确保已连接到 Internet。

1. 从 Windows“开始”菜单中选择“程序”（在 Windows XP 中选择“所有
程序”） > “Hewlett-Packard” > “HP 软件更新”。将打开“HP 软件更
新”窗口。

2. 单击“立即检查”。“HP 软件更新”将从 HP 网站搜索打印机软件更新。
如果计算机没有安装最新版本的打印机软件，“HP 软件更新”窗口中将出
现软件更新程序。

注意 如果计算机安装了最新版本的打印机软件，则“HP 软件更
新”窗口中出现以下信息：“此时没有系统可用的软件更新”。

3. 如果有软件更新可用，请单击软件更新旁的复选框将其选中。
4. 单击安装。
5. 按照屏幕上的说明完成安装。
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下载软件 (Mac)

注意 在使用“HP Photosmart 更新工具”前，确保已连接到 Internet。

1. 在 Mac 的 Finder 中，选择“转到” > “应用程序”。
2. 选择“Hewlett-Packard” > “Photosmart” > “HP Photosmart 更新工

具”。
3. 按照屏幕上的说明检查软件更新。

如果使用防火墙，请在更新工具中输入代理服务器信息。

打印机与墨盒的存放与搬运
为了保护打印机和墨盒，在不使用时应妥善存放。

存放和搬运打印机

打印机在设计上可经受长期或短期的闲置。将打印机存放在室内避光并且温度适
中的地方。

小心 防止墨水渗漏或溢出：搬运或存放打印机时不要让它侧边着地，并
且不要取出已安装的墨盒。

存放和搬运墨盒

搬运或存放打印机时，请始终将正在使用的墨盒留在打印机中以防止墨水变干。

小心 1 防止墨水流失或溢出：存放或搬运打印机时不要取出已安装的墨
盒，并避免让用过的墨盒留在打印机外过长时间。

小心 2 在拔下电源线之前，请确保打印机已完成关机过程。此过程可使
打印机正确安置打印头。

按照该提示进行操作有助于维护 HP 墨盒并确保稳定的打印质量：

将所有不使用的墨盒保存在其原始密封包装中，直到需要时再取出来。请在室温
下存放墨盒 (15-35 °C 或 59-95 °F)。

维护照片纸质量
要获得照片纸的最佳打印效果，请遵循本节的指导原则。

存放照片纸

● 将照片纸存放在其原始包装中，或放入可重新封装的塑料袋中。
● 将包好的照片纸存放在平坦、凉爽、干燥的平面上。
● 将不使用的照片纸放回塑料袋中，将纸张留在打印机内或暴露于外界环境中

会导致纸张卷曲。
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使用照片纸

● 请始终拿取照片纸的边缘以免留下指纹。
● 如果照片纸边缘卷曲，请将纸张放在塑料储存袋中并轻轻地朝卷曲的相反方

向弯曲，直到纸张恢复平整。
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7 疑难排解

HP Photosmart 打印机在设计上具有可靠易用的特点，本章回答了有关使用打印
机以及不用计算机进行打印的常见问题，其中包含有关下列主题的信息：

● 打印机硬件问题
● 打印问题
● 错误信息

有关其他疑难排解信息，请参阅：

● 软件安装疑难排解：打印机随附的“快速入门”手册。
● 打印机软件以及从计算机进行打印的疑难排解：HP Photosmart 打印机屏幕

帮助。有关查看屏幕上的“HP Photosmart 打印机帮助”的信息，请参阅欢
迎使用。

打印机硬件问题
在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

注意 如果要用 USB 电缆将打印机连接到计算机，HP 建议使用长度不超
过 3 米（10 英寸）的 2.0 高速兼容电缆。

“打印”指示灯呈蓝色闪烁，但打印机不打印

解决方法 打印机正在处理信息；请等待它完成。

“警示灯”亮起

解决方法

● 查看打印机屏幕上的说明。如果打印机上连有数码相机，请查看相机屏
幕上的说明。如果打印机上连有计算机，请查看计算机显示器上的说
明。

● 关闭打印机，然后拔下电源线。等待 10 秒钟，然后再插上电源线。打
开打印机电源。

如果使用上述方法后“警示灯”仍然亮起，请访问 www.hp.com/support 或
与 HP 支持部门联系寻求帮助。

打印机未找到保存于存储卡上的照片

解决方法 存储卡可能包含打印机无法直接从存储卡读取的文件类型。

● 将照片保存到计算机，然后从计算机进行打印。有关详细信息，请参
阅 HP Photosmart 屏幕帮助以及相机随附的文档。

● 下次拍照时，将数码相机设置为以打印机可直接从存储卡读取的文件类
型保存照片。有关支持的文件格式列表，请参阅打印机技术规格。有关
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将数码相机设置为以特定文件格式保存照片的说明，请参阅相机随附的
文档。

如果问题仍然存在，则可能需要重新格式化存储卡。

打印机已插上电源，但无法打开

解决方法

● 打印机可能消耗的功率太多。拔下打印机电源线。等待大约 10 秒钟，
然后插上电源线，打开打印机。

● 打印机所插入的接线板电源可能已经关闭。打开接线板开关，然后打开
打印机电源。

● 电源线可能损坏。确保电源线上的绿色指示灯点亮。

打开打印机时发出声响，或打印机一段时间不使用后发出声响

解决方法 打印机长时间不用后（约 2 周）或其电源中断然后恢复时， 可
能发出声响。这是正常现象。打印机正在执行自动维护程序以确保生成最佳
质量的输出。

打印机上的所有指示灯闪烁

解决方法 打印机出现硬件错误并可能需要维修。拔下打印机电源线。等
待 10 秒钟，然后再插上电源线。打开打印机电源。如果指示灯仍然闪烁，
请访问 www.hp.com/support 或与 HP 支持部门联系以寻求帮助。

打印问题
在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

当从控制面板打印时，打印机无法打印无边框照片

解决方法 请确保设置打印作业时选择了正确的布局。当选择照片和纸张尺
寸时，图像方框必须用桔色填充成实心，这表示无边框打印。

打印速度非常慢

解决方法 您可能遇到了以下一种情况：1) 正在打印含有高分辨率图形或照
片的 PDF 文件或项目，或 2) 选择了最高分辨率的打印输出。打印含有图形
或照片的大型复杂项目要比文本文档慢，尤其是分辨率较高时。
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纸张未从主纸盒正确送入打印机

解决方法

● 纸盒中可能装入了太多的纸张。取出一些纸张并尝试重新打印。
● 主纸盒可能未完全推入到位。将主纸盒完全推入到位。
● 可能没有正确调整纸张导轨和导板。确保纸张宽度导轨和长度导板紧靠

纸张边缘，同时保持纸张平整。
● 两张或多张纸可能粘在一起。从主纸盒取出纸张，呈扇形展开纸叠以将

纸张分开，然后重新放入纸张并尝试再次打印。
● 如果纸张起皱或弯曲，尝试使用其他纸张。
● 纸张可能太薄或太厚。为了获得最佳效果，请使用 HP 喷墨纸。有关详

细信息，请参阅选择合适的纸张。

打印出的纸张从出纸盒中掉落

解决方法 在打印时要始终展开出纸盒延长板。

打印出的纸张起皱或卷曲

解决方法 打印项目使用的墨水量比平时多。请从计算机上打印，并使用打
印机软件降低墨水饱和度。有关详细信息，请参阅 HP Photosmart 屏幕帮
助。

打印的文档是斜的或者不居中

解决方法

● 可能没有正确装入纸张。重新放入纸张，确保纸张在主纸盒中方向正
确，并且纸张宽度导轨和长度导板紧靠纸张边缘。有关装入纸张的说
明，请参阅装入纸张提示。

● 如果您使用双面打印附件，请尝试将其卸下，装回后检修门，然后重新
打印。

● 打印机可能需要校准。有关详细信息，请参阅校准打印机。

打印的颜色不尽人意

解决方法

● 其中一个彩色墨盒的墨水可能已用完，导致另一个颜色在打印时被替
代。从“工具”菜单查看墨水量图标以检查估计墨水量（设置 > 工具 >
显示墨水量指示器）。如果墨盒已空，请更换。有关详细信息，请参
阅插入墨盒。

● 打印机可能需要校准。有关详细信息，请参阅校准打印机。
● 打印头可能需要清洁。有关详细信息，请参阅保养与维护。
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打印时打印机不出纸或发生卡纸

解决方法

● 打印机可能需要维护。阅读打印机屏幕上的说明。
● 电源可能已关闭，或者连接松动。确保电源已打开且电源线连接牢固。
● 主纸盒或照片纸盒中可能缺纸。检查纸张是否正确装入。有关装入纸张

的说明，请参阅装入纸张提示。
● 如果在打印时卡纸，请尝试以下操作：

– 关闭打印机，然后拔下电源插头。清除打印机中任何阻塞纸张通道
的纸张。取下后检修门。轻轻地从打印机中取出卡纸，然后重新装
上后检修门。如果无法从打印机后面取出所有卡纸，请尝试打开位
于顶盖内的卡纸门，取出卡在打印机中间的纸张。有关清除卡纸的
两个位置的图示，请参阅纸张错误。清除卡纸后，插上打印机电源
线然后打开电源，尝试重新打印。

– 如果打印标签，请确保标签在通过打印机时没有从标签纸上脱落。

打印机输出空白页

解决方法

● 您可能已经开始打印，然后又取消了该打印作业。
如果在开始打印前取消了打印作业，打印机可能已经装入了纸张并准备
打印。下次打印时，打印机会在开始新的打印作业前先退出空白页。

● 可能将有大量数据的打印作业发送到打印机。
等待打印机维护打印头后再继续打印。

打印机要求打印校准页

解决方法 打印机需要定期执行打印头校准以保持最佳打印质量。

出现提示时，请装入 Letter 或 A4 尺寸的普通纸。丢弃或回收校准页。

无法使用默认打印设置打印照片

解决方法 您可能已经更改了选定照片的打印设置。应用于个别照片的打印
设置将取代默认打印设置。通过取消选择个别照片可以停止使用应用于该照
片的所有打印设置。有关详细信息，请参阅设置。

准备打印时打印机退出纸张

解决方法 日光直射可能会影响自动纸张传感器的正常工作。请将打印机移
到避光处。
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打印质量差

解决方法

● 其中一个墨盒可能墨水量太低，导致另一个颜色在打印时被替代。
从“工具”菜单查看墨水量图标以检查估计墨水量（设置 > 工具 > 显示
墨水量指示器）。如果墨盒中的墨水不足，请更换。有关详细信息，请
参阅插入墨盒。

● 使用打印机专用照片纸。为了获得最佳效果，请使用选择合适的纸张中
建议的纸张。

● 您可能打印到了纸张错误的一面上。确保打印面朝下放入纸张。
● 您可能在数码相机上选择了低分辨率设置。缩小图像尺寸并尝试再次打

印。为了在以后获得更好的效果，请为数码相机设置较高的照片分辨
率。

● 墨盒或打印头可能出现问题。请尝试以下操作：

– 将墨盒逐个取出再装上，确保它们都安装正确。
– 运行打印头自动清洁程序。有关详细信息，请参阅保养与维护。
– 校准打印机。有关详细信息，请参阅校准打印机。
– 如果在尝试所有上述解决方法后打印质量问题仍然存在，请联系 HP

支持部门。

未正确打印照片

解决方法

● 您可能没有正确装入照片纸。打印面朝下装入照片纸。
● 照片纸可能没有正确送入打印机。请尝试以下操作：

– 检查是否出现卡纸。有关详细信息，请参阅纸张错误。
– 将照片纸尽可能深地插入照片纸盒。
– 一次装入一张照片纸。

未打印在数码相机中标记要打印的照片

解决方法 有些数码相机可以在相机的内部存储器和存储卡上标记要打印的
照片。如果在内部存储器中标记了照片，然后又将照片从相机的内部存储器
转移到存储卡上，标记就会消失。请将照片从数码相机内部存储器转移到存
储卡后再标记要打印的照片。

错误信息
在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

打印机屏幕上出现的错误信息可分为以下几类：

● 纸张错误
● 墨盒错误
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● 存储卡错误
● 计算机打印错误

纸张错误

在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

错误信息：卡纸。清除卡纸，然后按“OK”。

解决方法 关闭打印机，然后拔下电源插头。清除打印机中任何堵塞纸张通
道的纸张。取下后检修门，轻轻地从打印机中取出被卡住的纸张，然后重新
装上后检修门。

1 取下后检修门以清除卡纸。

如果无法从打印机后面取出所有卡纸，请尝试打开位于顶盖内的卡纸门，取
出卡在打印机中间的纸张。

1 打开卡纸门清除卡在打印机中间的纸张。

重新插上打印机的电源插头，然后打开打印机电源。

错误信息：缺纸。装入纸张然后按 OK。

解决方法 装入纸张，然后按 OK 以再次打印。有关装入纸张的说明，请参
阅装入纸张提示。
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错误信息：不支持的介质尺寸。

解决方法 放入纸盒中的纸张尺寸不适用于本打印机。按 OK，然后放入支
持的纸张尺寸。有关支持的纸张尺寸列表，请参阅打印机技术规格。

错误信息：自动纸张传感器失效。

解决方法 自动纸张传感器被挡住或已损坏。尝试将打印机移到避光处，然
后按 OK 并重新打印。如果这样做无效，请访问 www.hp.com/support 或
与 HP 支持部门联系。

墨盒错误

在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

错误信息：安装了错误的墨盒

解决方法 首次安装和使用 HP Photosmart 打印机时，请确保安装打印机
随附的墨盒。这些墨盒中的墨水配方独特，可与打印头组件中的墨水混合使
用。

要解决这个问题，请用 HP Photosmart 打印机随附的墨盒更换有问题的墨
盒。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：墨盒不正确

解决方法 指定墨盒无法在设备初始化后使用。为 HP Photosmart 更换正
确的墨盒。可以在此印刷版指南的封底上找到用于该打印机的墨盒编号。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：请尽快更换墨盒

解决方法 指定的墨盒墨水不足。

可以使用打印头组件中剩余的墨水继续打印很短的时间。更换指定的墨盒或
按 OK 继续打印。

有关更换墨盒的详细信息，请参阅插入墨盒。
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错误信息：墨盒是空的

解决方法 指定墨盒已空，而且打印头墨水槽中的墨水也不足以进行正常的
打印和维修任务。用新的墨盒更换指定的墨盒。

● 如果黑色墨盒已空，可以选择打印机屏幕上显示的提示选项，使用其他
彩色墨盒继续打印。

● 如果彩色墨盒已空，可以选择打印机屏幕上显示的提示选项，使用黑色
墨盒继续打印。

根据打印作业的状态，可以按 OK 继续打印。如果 HP Photosmart 打印机
正在打印，请按“取消”并重新开始打印作业。

注意 打印的文本和照片质量与使用所有墨盒时有所不同。请尽快更
换空墨盒，否则将中止所有打印过程。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：不能打印

解决方法 指定墨盒的墨水已用完。

立即更换指定墨盒以便继续打印。

更换完墨盒后，HP Photosmart 才会继续打印。将中止所有打印过程。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：墨盒问题

解决方法 指定墨盒缺失或损坏。

立即更换指定墨盒以便继续打印。如果 HP Photosmart 未缺失墨盒，请清
洁墨盒触点。

有关更换墨盒的详细信息，请参阅插入墨盒。有关清洁墨盒触点的详细信
息，请参阅保养与维护。

如果 HP Photosmart 打印机未缺失墨盒，而且在清洁墨盒触点后仍然显示
此信息，请更换墨盒。取出有问题的墨盒，然后查看底部以 YYYY/MMM/DD
（年/月/日）格式表示的保修截止日期。如果在保修期之内，请与 HP 支持部
门联系以更换墨盒。

错误信息：墨水接近有效期。- 或 - 墨盒过期。

解决方法 每个墨盒都有保质期。确定保质期的目的是保护打印系统并确保
墨水质量。当显示墨水过期信息时，请取下并更换墨盒，然后关闭该信息。
您也可以按照计算机屏幕上的说明操作，不更换墨盒而继续打印。HP 建议
更换过期墨盒。HP 无法担保过期墨盒的质量或可靠性。由于使用过期墨水
而导致的设备维修不在保修范围之内。

有关更换墨盒的详细信息，请参阅插入墨盒。

第 7 章

52 HP Photosmart D7100 series



错误信息：非 HP 墨水

解决方法 更换指定墨盒或按 OK 继续打印。

HP 建议您使用原装 HP 墨盒。原装 HP 墨盒专门为 HP 打印机设计并经过
测试，有助于随时轻松获得优质的打印效果。

注意 HP 无法担保非 HP 墨水的质量和可靠性。由于使用非 HP 墨水
导致的打印机故障或损坏不在保修范围之内。

如果您确信购买的是原装 HP 墨盒，请访问：

www.hp.com/go/anticounterfeit

错误信息：原装 HP 墨水已用完

解决方法 更换指定墨盒或按 OK 继续打印。

HP 建议您使用原装 HP 墨盒。原装 HP 墨盒专门为 HP 打印机所设计并经
过测试，有助于随时轻松获得优质的打印效果。

注意 HP 无法担保非 HP 墨水的质量和可靠性。由于使用非 HP 墨水
导致的打印机故障或损坏不在保修范围之内。

如果您确信购买的是原装 HP 墨盒，请访问：

www.hp.com/go/anticounterfeit

错误信息：定期维护

解决方法 必须校准打印机以确保优质的打印质量。在主纸盒中放入未用过
的 Letter 或 A4 尺寸的普通白纸，按 OK。HP Photosmart 打印机将校准打
印头、校准打印机，然后打印测试页。回收或丢弃测试页。

错误信息：校准错误

解决方法

● 如果校准打印机时主纸盒中有彩色纸张或照片纸，校准可能会失败。在
主纸盒中装入未用过的 Letter 或 A4 尺寸的普通白纸，然后重新校准。
如果校准仍未成功，可能是传感器或墨盒有问题。联系 HP 支持部门。

● 墨盒或传感器有问题。联系 HP 支持部门。

错误信息：墨盒底座被卡住

解决方法 清除卡住打印头组件的任何异物。

清理打印头组件

1. 打开顶盖，然后打开卡纸门。
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1 打开卡纸门以清理打印头组件。

2. 清除卡住打印头组件的任何异物，包括纸张和包装材料。
3. 关闭打印机电源，然后重新打开。
4. 关闭卡纸门和顶盖。

错误信息：供墨系统故障

解决方法 打印头或供墨系统出现故障，HP Photosmart 不能再进行打印。

关闭打印机，然后拔下电源线。等待 10 秒钟，然后再插上电源线。如果此
操作无法清除该错误信息，请联系 HP 支持部门。

存储卡错误

在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

错误信息：缺失单张照片。- 或 - 缺失多张照片。

解决方法 打印机无法读取存储卡中的文件，或者存储卡中缺失打印作业中
所指定的一个或多个文件。请使用数码相机而不是存储卡将照片保存到计算
机。如果缺失照片，则可能是您不小心从存储卡中将其删掉了。

错误信息：读取存储时出错。作业已取消。按“OK”。- 或 - 文件目录结构已破坏。-
或 - 存储卡可能已损坏。作业已取消。按“OK”。

解决方法 打印机不能读取存储卡上的数据，进而无法完成当前的任何打印
作业。数据可能已损坏或存储卡本身有问题。

● 将文件保存到计算机，然后从计算机访问。
● 如果这样做无效，请使用新存储卡或用数码相机重新格式化存储卡。卡

上的所有照片都将丢失。
● 如果这样做无效，照片文件可能已损坏或者不可读。在联系 HP 支持部

门之前，请换一张存储卡以确定是打印机故障还是存储卡故障。
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错误信息：不能打印照片。

解决方法 为打印作业指定的照片中，有超过 10 张可能已损坏、缺失或者
是不支持的文件类型。有关支持的文件类型信息，请参阅打印机技术规格。

● 使用数码相机而不是存储卡将照片保存到计算机。
● 将文件保存到计算机，并从计算机打印。
● 打印照片索引并重新选择照片。有关详细信息，请参阅打印照片。

错误信息：存储卡已加密，不能访问。

解决方法 由于存储卡已加密，打印机不能访问。请执行下列步骤：

1. 从打印机中取出存储卡。
2. 将存储卡插入最初用于对其进行加密的设备中。
3. 清除存储卡上的密码。
4. 取出存储卡并将其重新插入打印机的存储卡插槽。
5. 尝试重新打印。

错误信息：存储卡被锁定，不能访问。

解决方法 确保卡上的锁定开关位于解锁位置。

错误信息：未完全插入存储卡，请将其插入到位。

解决方法 打印机可以检测到存储卡但不能读取。将存储卡轻轻推入存储卡
插槽直到其停住。有关详细信息，请参阅插入存储卡。

错误信息：每次仅使用 1 张存储卡。请取出一张存储卡。- 或 - 每次仅使用 1 个设备。请
卸下/断开一个设备。

解决方法 打印机中同时插入了一种以上的存储卡，或者在插入存储卡的同
时相机端口连有数码相机。取出存储卡或断开相机连接，直到打印机中只有
一张卡或只连接一台相机。

错误信息：已取出存储卡。已取消作业。按“OK”。

解决方法 打印机从存储卡打印文件时取出了存储卡。请执行下列步骤：

1. 按 OK。
2. 重新插入存储卡并打印选定的照片。必须将存储卡保留在插槽中直到完

成打印作业。

要避免以后损坏存储卡，请勿在读取时将其从打印机存储卡插槽中取出。有
关详细信息，请参阅取出存储卡。
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错误信息：相机选择 (DPOF) 文件出错。

解决方法 打印机不能读取 DPOF 文件，因为存储卡上的数据已损坏或出
现错误。请使用打印机控制面板重新选择照片。有关详细信息，请参阅从存
储卡打印照片。

错误信息：有些相机选定的照片不在卡上。

解决方法 有些相机选定的照片缺失或者已被删除。请尝试以下操作：

● 确认您没有不小心将该照片从存储卡上删除。
● 使用数码相机重新选择照片。
● 打印新的照片索引页以查看每张照片相应的索引编号。有关详细信息，

请参阅打印照片。

错误信息：无法显示该照片。- 或 - 无法显示所有照片。- 或 - 照片已损坏。

解决方法 存储卡上包含打印机不支持的图像格式，或文件已损坏。有关支
持的图像格式列表，请参阅打印机技术规格。使用计算机读取照片。有关通
过计算机读取照片的详细信息，请参阅从计算机打印。

错误信息：不支持的存储卡类型。

解决方法 用相机将照片传输到计算机，然后从计算机打印。

错误信息：有些照片编号不在卡上。

解决方法 用相机将照片传输到计算机，然后从计算机打印。如果仍缺失照
片，则可能已从存储卡将其删除。

打印时发生计算机和连接错误

在与 HP 支持部门联系之前，请阅读本节的疑难排解提示或访问网站
www.hp.com/support 的在线支持服务。

错误信息：打印机内存已满，作业已取消。请按“OK”。

解决方法 打印机在打印照片时遇到问题。请尝试以下操作：

● 要清空打印机内存，请关闭打印机，然后重新打开。
● 一次打印少量照片。
● 将照片保存到计算机，并从计算机打印。
● 使用存储卡读取器将文件保存到计算机并从计算机打印。
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错误信息：通信错误。检查计算机连接。按“OK”。- 或 - 未接收到数据。检查计算机
连接。按“OK”以继续。- 或 - 计算机无响应。

解决方法 打印机无法与计算机进行正常通信。可能是打印机软件不工作或
者电缆连接不牢。请确保 USB 电缆牢固地连接在计算机上和打印机背面的
USB 端口上。如果电缆连接牢固，请确认已安装打印机软件。

错误信息：打印期间相机连接被断开。

解决方法 该打印作业将被取消。将 USB 电缆重新连接到相机和打印机，
然后重新发送打印作业。
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8 HP 支持

支持程序

如果遇到问题，请按以下步骤操作：

1. 查阅 HP Photosmart 随附的文档。
2. 访问 HP 在线支持网站：www.hp.com/support。所有 HP 客户都可以访问

HP 在线支持。在这里可以最快速地获取最新设备信息和专家帮助，并包含
以下功能：

– 快速访问有资质的在线支持专家
– HP Photosmart 软件和驱动程序的更新
– 为常见问题提供有用的 HP Photosmart 和疑难排解信息
– 注册 HP Photosmart 后可提供主动设备更新、支持提醒以及 HP 新闻简

报
3. 仅限于欧洲：与当地的经销商联系。如果 HP Photosmart 出现硬件故障，

需要将其送回到当地的购买点。（此服务将在打印机的保修期限内免费提
供。保修期过后，将收取服务费。）

4. 联系 HP 支持。可选择的支持种类和可用性随设备、国家/地区以及语言而
异。

HP 电话支持
要获取支持电话号码的列表，请参阅前盖内的电话号码表。

电话支持期

北美、亚太地区和拉丁美洲（包括墨西哥）可享有一年电话支持服务。要确定欧
洲、中东和非洲的电话支持期，请访问 www.hp.com/support。您需要支付电话
公司的标准电话费。

致电

请在计算机和 HP Photosmart 前致电 HP 支持。准备提供以下信息：

● 设备型号（在设备前面的标签上）
● 设备序列号（在设备后部或底部）
● 发生故障时显示的信息
● 回答下列问题：

– 以前出现过这种情况吗？
– 能否使之再现？
– 在出现这种情况前，是否在计算机上添加了新硬件或软件？
– 在出现这种情况前，是否出现其他情况（例如，发生雷电和移动设备

等）？
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电话支持期过后

电话支持期过后，仍可获得 HP 的支持，但需要支付一定的费用。也可以在 HP
在线支持网站获取支持：www.hp.com/support。请与 HP 经销商联系或拨打所
在国家/地区的支持电话号码，以了解支持选项详细信息。
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A 技术规格

本节列出了安装 HP Photosmart 软件所需的最低系统要求，并提供选定打印机的技术规
格。

要得到完整的打印机技术规格和系统要求列表，请参阅屏幕上的“HP Photosmart 打印
机帮助”。有关查看 HP Photosmart 屏幕帮助的信息，请参阅欢迎使用。

系统要求

组件 Windows 计算机最低要求 Macintosh 最低要求

操作系统 Microsoft  Windows 98、
2000 Professional、Me、
XP Home 和 XP
Professional

Mac  OS X 10.3、10.4 和
高版本

处理器 Intel  Pentium  II（或同性
能的处理器）或更快

G3、G4、G5 或 Intel Core
Duo 或更高版本

RAM 64 MB（建议使用 128 MB） Mac OS X 10.3、10.4 和更
高版本：128 MB

可用磁盘空间 500 MB 150 MB

视频显示器 800 x 600，16 位或更高 800 x 600，16 位或更高

CD-ROM 驱动器 4x 4x

连接 USB：Microsoft Windows
98、2000 Professional、
Me、XP Home 和 XP
Professional
PictBridge：使用前面的相
机端口

Bluetooth：使用可选的
HP Bluetooth 无线适配器

USB：前方和后方端口
（Mac OS X 10.3、10.4 以
及更新版本）

PictBridge：使用前面的相
机端口

Bluetooth：使用可选的
HP Bluetooth 无线适配器

浏览器 Microsoft Internet Explorer
5.5 或更高版本

-

打印机技术规格

类别 技术规格

连接 USB：Microsoft Windows 98、2000 Professional、
Me、XP Home 和 XP Professional；Mac OS X
10.3、10.4 和更高版本

图像文件格式 JPEG 基线
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类别 技术规格

TIFF 24 位 RGB 未压缩隔行扫描

TIFF 24 位 YCbCr 未压缩隔行扫描

TIFF 24 位 RGB Packbits 隔行扫描

TIFF 8 位灰色未压缩/Packbits
TIFF 8 位彩色未压缩/Packbits
TIFF 1 位未压缩/Packbits/1D Huffman

视频文件格式 Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

介质规格 建议的最大长度：61 厘米（24 英寸）

建议的最大纸张厚度：292 微米（11.5 密耳）

建议的最大信封厚度：673 微米（26.5 密耳）

支持的介质尺寸 从计算机打印时支持的尺寸

7.6 x 12.7 厘米至 22 x 61 厘米（3 x 5 英寸至
8.5 x 24 英寸）

从控制面板打印时支持的尺寸

公制：A6、A4、10 x 15 厘米（带或不带裁边）；英
制：3.5 x 5 英寸、4 x 6 英寸（带或不带裁边）、
4 x 12 英寸、5 x 7 英寸、8 x 10 英寸、8.5 x 11 英
寸；其他：Hagaki 卡和 L 尺寸

支持的介质类型 纸张（普通纸、喷墨纸、照片纸和全景照片纸）

信封

投影胶片

标签纸

卡片：索引卡、贺卡、Hagaki 卡、A6、L 尺寸

烫印转印纸

Avery C6611 和 C6612 照片不干胶贴纸：10 x 15 厘
米（4 x 6 英寸），每页有 16 个矩形或椭圆形标签

存储卡 CompactFlash I 型和 II 型
Microdrive
MultiMediaCard
Secure Digital
Memory Stick
xD-Picture Card

存储卡支持的文件格式 打印：请参阅表前面列出的图形文件格式。

保存：所有文件格式

纸盒 – 支持的介质尺寸 主纸盒

附录 A
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类别 技术规格

8 x 13 厘米至 22 x 61 厘米（3 x 5 英寸至
8.5 x 24 英寸）

照片纸盒

不超过 10 x 15 厘米（4 x 6 英寸），带或不带裁边

出纸盒

所有支持的主纸盒和照片纸盒尺寸

纸盒容量 主纸盒

100 张普通纸

14 个信封

20 - 40 张卡片（视厚度而定）

30 张标签纸

25 张投影胶片、烫印转印纸或照片纸

10 张照片纸

照片纸盒

出纸盒

20 张照片纸

50 张普通纸

10 张卡片或信封

25 张标签或烫印转印纸

工作环境 建议的温度范围：15–30 °C (59-86 °F)
最大温度范围：5–40 °C (41-104 °F)
储存温度范围：-40–60 °C (-40-140 °F)
建议的湿度范围：20–80% RH
最大湿度范围：10–80% RH

物理规格 高度：17.9 厘米（6.8 英寸）

宽度：46.25 厘米（18.2 英寸）

厚度：38.7 厘米（15.25 英寸）

重量：7.7 千克（17.0 磅）

耗电量 打印时平均耗电量：75 瓦
打印时最大耗电量：94 瓦
闲置时耗电量：13.3–16.6 瓦

电源型号 HP 部件号：0957-2105

电源要求 100–240 VAC (± 10%), 50–60 Hz (± 3 Hz)

墨盒 HP 黄色墨盒

HP 青色墨盒

HP 淡青色墨盒

（续）
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类别 技术规格

HP 品红色墨盒

HP 淡品红色墨盒

HP 黑色墨盒

注意 可用于该打印机的墨盒编号在本手册印
刷版的封底上。如果您已经使用过几次本打印
机，则可在打印机软件中找到墨盒编号。有关
详细信息，请参阅插入墨盒。

打印速度（最大） 黑白打印：每分钟 32 页
彩色打印：每分钟 31 页
照片：14 秒打印一张 10 x 15 厘米（4 x 6 英寸）的
照片

USB 支持 Microsoft Windows 98、2000 Professional、Me、
XP Home 和 XP Professional
Mac OS X 10.3、10.4 和更新

HP 建议使用长度不超过 3 米（10 英尺）的 USB 2.0
全速兼容电缆。
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B HP 保修条款
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1 Welcome
Thank you for purchasing an HP Photosmart D7100 series printer! With this new photo
printer you can print beautiful photos, save photos to a computer, and create fun and
easy projects with or without a computer.
This guide primarily explains how to print without connecting a computer. To learn how
to print from a computer, install the printer software and view the electronic Help. For an
overview of using a computer and the printer together, see Printing from a computer. For
information about installing the software, see the Quick Start guide.
Home users can learn how to:
● Print borderless photos from the printer or from a computer
● Choose a photo layout
● Convert a color photo to black and white, or apply a color effect such as Sepia or

Antique
The printer comes with the following documentation:
● Quick Start Guide: The  Quick Start Guide explains how to set up the printer, install

the printer software, and print your first photo.
● User Guide: The User Guide is the book you are reading. This guide describes the

basic features of the printer, explains how to use the printer without connecting a
computer, and contains hardware troubleshooting information.

● Onscreen help: The onscreen HP Photosmart printer help describes how to use
the printer with a computer and contains software troubleshooting information.

Special features
New features and media make it easier than ever to produce high-quality photos:
● When you use the new HP Advanced Photo Paper (also called HP Photo Paper in

some countries/regions), special sensors in the printer detect a mark on the back of
the paper and automatically select the optimal print settings. For more information
about this new paper, see Choose the right paper.

● HP Real Life technologies make it easy for you to get better photos. Automatic red
eye removal and adaptive lighting to enhance detail in shadows are just a few of the
many technologies included. You can explore the many editing and enhancing
options from both the control panel and from the printer software. To access these
features from the control panel, see Improving photo quality. To learn how to find
them in the software, see HP Real Life technologies features.

Accessing the onscreen HP Photosmart printer help
After you have installed the HP Photosmart printer software on a computer, you can view
the onscreen HP Photosmart printer help:
● Windows PC: From the Start menu, select Programs (in Windows XP, select All

Programs) > HP > HP Photosmart D7100 series > Photosmart Help.
● Macintosh: From the Finder Help menu, choose Mac Help. From the Help

Viewer Library menu, choose HP Photosmart Mac Help.
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Printer parts

Front of printer
1 On: Press this button to turn on the printer.
2 Top cover: Lift this cover to access the ink cartridges and to clear paper jams. To lift the cover,

grasp the top cover below the HP logo and pull upward.
3 Printer Screen: Use this screen to view photos, menus, and messages.
4 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
5 Main tray: Pull out this tray and load paper, transparencies, envelopes, or other media with

the side to be printed facing down.
6 Photo tray: Lift the output tray, pull out this tray, and load small-size paper up to 10 x 15 cm

(4 x 6 inch) into the photo tray for printing with the side to be printed facing down. The paper
may be tabbed or untabbed.

7 Memory card slots: Insert memory cards here. For a list of supported memory cards, see
Insert memory cards.

8 Camera port: Connect a PictBridge™ digital camera, the optional HP Bluetooth® wireless
printer adapter, or an iPod.

Back of printer
1 Power cord connection: Use this port to connect the power cord included with the printer.
2 USB port: Use this port to connect the printer to a computer.
3 Rear access door: Remove this door to clear paper jams or to install the optional

HP Automatic Two-sided Printing Accessory. See Optional accessories.
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Main and Output trays
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the main tray.
2 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
3 Output tray extender: Pull towards you to extend the output tray to catch your printouts.
4 Main tray: Pull out this tray and load plain paper, transparencies, envelopes, or other media

with the side to be printed facing down.
5 Main tray grip: Pull toward you to extend the Main tray.
6 Paper-length guide: Adjust this guide to fit close to the end of the paper in the main tray.

Photo tray
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the photo tray.
2 Paper-length guide: Adjust this guide to fit close to the end of the paper in the photo tray.
3 Photo tray grip: Pull toward you to extend the photo tray.
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Control panel
1 On: Turn on the printer or put it into power save mode.
2 Back: Step back one screen at a time.
3 Home: Press to return to the home screen.
4 Navigation arrows: Adjust the crop box, navigate menu choices, and control the playback

of a video clip.
5 OK: Select a highlighted item, menu or dialog choice, and play/pause a video clip during

playback.
6 Print Preview: View a preview of the selected photo or photos.
7 Print: Print the selected photos from the inserted memory card, or from a camera connected

to the front camera port.
8 Cancel: Stops a print job.
9 Rotate: Rotate a photo or a crop box.
10 Zoom (+)(-): Zoom in or out of a photo or crop box. You can also press Zoom (-) to view

photos four at a time when viewing a photo at normal magnification.
11 Photo Fix: Automatically enhances and applies lighting, contrast, focus and red eye removal

features to all printed photos.

Indicator lights
1 On light: Solid blue if the printer is on, otherwise it is off.
2 Attention light: Flashes when there is an error condition. See the printer screen for

instructions or information about the error. For more information, see The Attention light is
on.

3 Print light: Solid blue when the printer is on and ready to print, flashes blue when the printer
is printing or busy with self-maintenance.

4 Photo Fix light: Solid blue when the Photo Fix function is turned on.
5 Memory Card light: Solid blue if a memory card is inserted, flashes if the printer is accessing

a memory card, off if no memory card is inserted or if more than one card is inserted. See the
printer screen for instructions.
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Optional accessories
There are several optional accessories available for the printer that enhance its portability
for printing anywhere, anytime. The appearance of the accessories may vary from what
is shown.
To purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/go/supplies (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)

Accessory name Description

HP Automatic Two-sided Printing
Accessory

This accessory automatically flips each
page to print on both sides. You will save
money (two-sided printing reduces paper
consumption) and time (no need to
remove the paper and reinsert it to print on
the back), plus you will make bulky
documents more manageable.
This accessory may not be available in all
countries/regions.

HP Bluetooth® wireless printer
adapter
1 Insert the Bluetooth adapter into the

front camera port

The HP Bluetooth® wireless printer
adapter goes into the camera port on the
front of the printer. This adapter lets you
use Bluetooth wireless technology for
printing from many Bluetooth-enabled
devices, including digital cameras,
camera phones, and PDAs.
For more information on printing with this
accessory, go to www.hp.com/go/
bluetooth.

Printer menu
Press the home button to access the home screen. You can access all of the functions
from the home screen as well as setup menus.
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View & Print
Wizard: Use the wizard to guide you through the printing process. Also use the wizard
to improve photo quality and apply advanced photo effects such as brightness and color
effects.
4×6: Use to print 4×6 inch (10 × 15 cm) photographs.
Enlargement: Use Enlargement to print different photo sizes.
Print All: Select to print all the photos from the memory card inserted in the printer.
Other Print Projects: Use Other Projects to print panoramic, HP CD/DVD Tattoos, wallet
prints, and passport photos.
– Panorama Prints: Select to turn panoramic printing On or Off (default). Select

On to print all selected photos with a 3:1 aspect ratio; load 10 x 30 cm (4 x 12 inch)
paper before printing.

– HP CD/DVD Tattoos: Select to print labels for CD/DVDs.
– Wallet Prints: Use to print wallet-sized photos.
– Passport Photos: Select to print a passport photo.

Save
Select Save to save selected images to a connected PC.

Share
Use Share to select and share photos through HP Photosmart Share.

Settings
● Tools: Use tools to display the ink gauge, adjust the print quality, print a sample

page, print a test page, and to clean and align cartridges.
– Display Ink Gauge: Use to enable an ink supply gauge on the home screen.
– Print sample page: Select to print a sample page, which is useful for checking

the print quality of the printer. This feature is not available in all printer models.
– Print test page: Select to print a test page containing information about the

printer that can help in troubleshooting problems.
– Clean Printhead: Select to clean the print head when white lines or streaks

appear in your printouts. After the cleaning finishes, the printer prints a self test
report. You have the option to clean the print head again if the report shows
print quality problems.

– Align printer: Select to align the printer when white lines or streaks appear in
your printouts.

● Bluetooth
– Device address: Some devices with Bluetooth wireless technology require you

to enter the address of the device they are trying to locate. This menu option
shows the printer address.

– Device name: You can select a name for the printer that appears on other
devices with Bluetooth wireless technology when they locate the printer.

– Passkey: When the Bluetooth Security level of the printer is set to High, you
must enter a passkey to make the printer available to other Bluetooth devices.
The default passkey is 0000.

– Visibility: Select Visible to all (default) or Not visible. When Visibility is set
to Not visible, only devices that know the printer address can print to it.
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– Security level: Select Low (default) or High. The Low setting does not require
users of other devices with Bluetooth wireless technology to enter the printer
passkey. High requires users of other devices with Bluetooth wireless
technology to enter the printer passkey.

– Reset Bluetooth options: Select to reset all items in the Bluetooth menu to
their default values.

● Help Menu: Use the help menu for instructions about using the printer.
– Cartridges: Select to see an animation of how to install an ink cartridge.
– Main Tray Loading: Select to read main tray paper loading instructions.
– Photo Tray Loading: Select to read photo tray paper loading instructions.
– Paper jams: Select to see an animation of how to clear a paper jam.
– Camera connect: Select to read instructions on how to connect a PictBridge

camera to the printer.
● Preferences

– 4 × 6 print paper size: Choose Ask before print to select the paper type and
size each time you print (default).

– Print quality: Choose either Best (default) or Normal print quality.
– Paper Type: Select Automatic (default) and the printer automatically detects

the paper type and size.
– Date Stamp: Use this option to include the date and/or time on your printed

photos.
– Colorspace: Choose a colorspace. The Auto-select default tells the printer to

use the Adobe RGB colorspace, if available. The printer defaults to sRGB if
Adobe RGB is not available.

– PictBridge Tray Select: Use to select the default paper tray for printing through
the PictBridge connection.

– Video enhancement: Select On (default) or Off. When you select On, the
quality of photos printed from video clips is improved.

– Restore Factory Defaults: Restores factory settings for all menu items
except Select language and Select country/region (under Language in
Preference menu) and Bluetooth settings (under Bluetooth in the main printer
menu). This setting does not affect HP Instant Share or Network defaults.
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2 Get ready to print
This section includes the following topics:
● Load paper
● Insert ink cartridges
● Insert memory cards

Load paper
Learn how to choose the right paper for your print job and how to load it into the input
tray for printing.

Choose the right paper
Use HP Advanced Photo Paper. It is especially designed to work with the inks in your
printer to create beautiful photos.
For a list of available HP-designed photo paper, or to purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/eur/hpoptions (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)
The printer is set by default to print the best quality photos on HP Advanced Photo Paper.
If you print on a different type of paper, be sure to change the paper type from the printer
menu. See Printer menu.

Paper loading tips
Paper loading tips:
● Load paper with the side to be printed facing down.
● You can print photos and documents on a wide variety of paper sizes, from 8 x 13 cm

(3 x 5 inch) up to 22 x 61 cm (8.5 x 24 inch). The 10 x 15 cm (4 x 6 inch) photo paper
is available with and without tabs.

● Before loading paper, pull the out main paper tray and slide out the paper-width and
paper-length guides to make room for the paper. After loading paper, adjust the
guides to fit close to the edges of the paper without bending the paper. When finished
loading paper, push the main tray back in all the way.

● Load only one type and size of paper at a time in the same tray.
● After loading paper, extend the output tray extension and raise the backstop to catch

your printed pages.

Load the main tray
Any supported photo or plain paper media
1. Extend the main tray.
2. Slide the paper-width and paper-length guides to their outermost positions.
3. Load paper with the side to be printed facing down. Make sure the stack of paper

fits loosely under the tab on the paper-length guide.
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1 Paper-width guide
2 Paper-length guide

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper.

5. Push the main tray all the way in.

1 Push in the main tray all the way

Load the photo tray
Use photo paper up to 10 x 15 cm (4 x 6 inch) with or without tabs, Hagaki cards, A6
cards, and L-size cards.
1. Lift the output tray and extend the photo tray.
2. Adjust the paper-width and paper-length guides outward to make room for the paper.

1 Output tray
2 Paper-width guide
3 Paper-length guide

3. Load up to 20 sheets of paper into the photo tray with the print side down. If you are
using tabbed paper, insert the paper so the tab is closer to you.

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper. Make sure the stack of paper fits loosely under the tab on the paper-
length guide.

5. Push in the photo tray.
6. Close the output tray.
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1 Paper-width guide
2 Paper-length guide
3 Photo tray grip.

Insert ink cartridges
The first time you set up and use your HP Photosmart printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink cartridges is
specially formulated to mix with the ink in the print head assembly.

Purchasing replacement ink cartridges
When purchasing replacement cartridges, refer to the cartridge numbers that appear on
the back cover of this guide. These cartridge numbers may vary by country/region.

Note If you have already used the printer several times and you have installed
the HP Photosmart printer software, you can also find the cartridge numbers in
the printer software. Windows users: Right-click the HP Digital Imaging Monitor
icon in the Windows taskbar, and select Launch/Show HP Solution Center.
Select Settings, then Print Settings, and then Printer Toolbox. Click the
Estimated Ink Levels tab, and then click Ink Cartridge Information. To order
ink cartridges, click Shop Online. Mac users: Click HP Photosmart Studio in
the Dock. In the HP Photosmart Studio toolbar, click Devices. From the
Information and Settings pop-up menu, choose Maintain Printer and then
click Launch Utility. In the Configuration Settings list, click Supply Info.
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Ink cartridge tips
HP Vivera Inks deliver true-to-life photo quality and exceptional fade resistance resulting
in vivid colors that last for generations! HP Vivera Inks are specially-formulated and
scientifically tested for quality, purity and fade resistance.
For best print quality, HP recommends that you install all retail ink cartridges before the
install-by date stamped on the box.
For optimum printing results, HP recommends using only genuine HP ink cartridges.
Genuine HP ink cartridges are designed and tested with HP printers to help you easily
produce great results, time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer service
or repairs required as a result of printer failure or damage attributable to the use
of non-HP ink will not be covered under warranty.

Ink cartridge
1 Do not insert objects into these holes

Caution To prevent ink loss or spillage: leave the ink cartridges installed while
transporting the printer, and avoid leaving used ink cartridge(s) out of the printer
for extended lengths of time.

Ink cartridge warranty information
The HP ink cartridge(s) warranty is applicable when the product is used in its designated
HP printing device. This warranty does not cover HP ink products that have been refilled,
remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted
and the end of warranty date has not been reached. The end of warranty date, in YYYY/
MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see HP Warranty.
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Inserting or replacing the ink cartridges
1. Make sure the power is on, then lift the top cover. Make sure all packing material

has been removed from inside the printer.

2. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the
printer, then lift the latch.
The ink cartridge areas are color-coded for easy reference. Lift the latch below the
appropriate color to insert or replace a cartridge. From left to right, the ink cartridges
are black, yellow, light cyan, cyan, light magenta, and magenta.

1 Ink cartridge latch for the black ink cartridge
2 Ink cartridge area for the color ink cartridges

3. If you are replacing a cartridge, remove the old cartridge by pulling it toward you out
of its slot.

Recycle the old cartridge. The HP Inkjet Supplies Recycling Program is available in
many countries/regions and lets you recycle used ink cartridges free of charge. For
more information, go to www.hp.com/hpinfo/globalcitizenship/environment/recycle/
inkjet.html.

4. Remove the new ink cartridge from its packaging, and while holding it by the handle,
slide the ink cartridge into the empty slot.
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Make sure you insert the ink cartridge into the slot that has the same shaped icon
and color as the new cartridge. The copper-colored contacts should be facing the
printer as the ink cartridge is inserted.

Note The first time you set up and use the printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink
cartridges is specially formulated to mix with the ink in the print head
assembly.

5. Press down on the gray latch until it clicks into place.

6. Repeat steps 2 through 5 for each ink cartridge you are replacing.
You must install all six cartridges. The printer will not work if an ink cartridge is
missing.

7. Close the top cover.

Insert memory cards
After you have taken pictures with a digital camera, you can remove the memory card
from the camera and insert it into the printer to view and print your photos. The printer
can read the following types of memory cards: CompactFlash™, Memory Sticks,
Microdrive™, MultiMediaCard™, Secure Digital™, and xD-Picture Card™.

Caution Using any other type of memory card may damage the memory card
and the printer.

To learn about other ways of transferring photos from a digital camera to the printer,
see Connecting to other devices.

Supported file formats
The printer can recognize and print the following file formats directly from a memory card:
JPEG, uncompressed TIFF, Motion JPEG AVI, Motion-JPEG QuickTime, and MPEG-1.
If your digital camera saves photos and video clips in other file formats, save the files to
your computer and print them using a software program. For more information, see the
electronic Help.
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Inserting a memory card

Memory card slots
1 xD-Picture Card
2 Memory Stick
3 Compact Flash I and II, Microdrive
4 Secure Digital, MultiMediaCard (MMC)

Memory card types
Find your memory card in the following table and use the instructions to insert the card
into the printer.
Guidelines:
● Insert only one memory card at a time.
● Gently push the memory card into the printer until it stops. The memory card slot

allows for only a portion of the card to insert into the printer; do not try to force the
memory card all the way into the printer.

● When the memory card is inserted correctly, the memory card light flashes and then
remains solid green.

Caution 1 Inserting the memory card any other way may damage the card and
the printer.

Caution 2 Do not pull out a memory card while the memory card light is flashing
green. For more information, see Removing a memory card.

Memory card How to insert the memory card

CompactFlash ● Front label faces up, and if the label has an arrow, the arrow points
toward the printer

● Edge with metal pinholes goes into the printer first
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Memory card How to insert the memory card

Memory Stick ● Angled corner is on the left
● Metal contacts face down
● If you are using a Memory Stick Duo or Memory Stick PRO Duo

card, attach the adapter that came with the card before you insert
the card into the printer

Microdrive ● Front label faces up, and if the label has an arrow, the arrow points
toward the printer

● Edge with metal pinholes goes into the printer first

MultiMediaCard ● Angled corner is on the right
● Metal contacts face down

Secure Digital ● Angled corner is on the right
● Metal contacts face down

xD-Picture Card ● Curved side of card points toward you
● Metal contacts face down

Removing a memory card
Wait until the Memory Card light stops flashing, then gently pull the memory card to
remove it from the printer.

Caution Do not pull out a memory card while the Memory Card light is flashing.
A flashing light means that the printer is accessing the memory card. Removing
a memory card while it is being accessed may damage the printer and the memory
card or corrupt the information on the memory card.
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3 Printing photos without a
computer
The HP Photosmart D7100 series printer lets you select, enhance, and print photos
without even turning on the computer. Once you've set up the printer using the
instructions in the Quick Start Guide, you can insert a memory card in the printer and
print your photos using the buttons on the printer control panel.
You can also print photos directly from a digital camera. For more information, see Print
photos from a digital camera.

Printing photos
You can print photos without a computer in several different ways:
● Insert a memory card with photos on it into one of the memory card slots on the

printer
● Connect a PictBridge digital camera to the camera port on the front of the printer
● Install the optional HP Bluetooth® wireless printer adapter and print from a digital

camera with Bluetooth wireless technology

Print photos from a memory card
You can print photos from a memory card by inserting the card into the printer and using
the printer control panel to view, select, enhance, and print photos. You can also print
camera-selected photos—photos you marked for printing using a digital camera—
directly from a memory card.
Printing from a memory card is quick and easy, and does not drain the digital camera
batteries.

Print one or more photos
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print, then press OK.
2. Select 4×6 or Enlargement to select your desired photo size, then press OK.
3. Select your desired paper size, then press OK.
4. Select a layout then press OK.
5. Using the arrow keys, scroll through the available photos.
6. Press OK to select one or more images.

– Press Zoom - to view up to 9 images on the printer screen.
– Press the up arrow to increase the number of prints for the selected image.

7. Press Print to print the selected photographs.
Check the Photo tray light to verify that the correct tray is selected — the light should be
off for the Main tray and on for the Photo tray.
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Print all photos on the memory card
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print, then press OK.
2. Select Print All.
3. Select the desired paper size and press OK.

➔ Select a layout and press OK.
4. Select Print Now and press OK.

Print camera-selected photos from a memory card
When you select photos for printing using a digital camera, the camera creates a Digital
Print Order Format (DPOF) file that identifies the selected photos. The printer can read
DPOF 1.0 and 1.1 files directly from a memory card.
1. Use the digital camera to select the photos you want to print. For more information,

see the documentation that came with the camera.
2. If you select default as the photo layout with the camera, select Layout to select a

photo layout.
If you select a photo layout other than default with the camera, photos print in the
camera-selected layout regardless of the printer setting.

3. Load the desired paper.
4. Remove the memory card from the digital camera and insert it into the printer.
5. When a message appears on the printer screen asking if you want to print the

camera-selected photos, press OK.
The photos you selected with the camera begin printing.

If the printer cannot find or read all of the camera-selected photos on the card, it prints
the photos that it can read.
After printing, the printer deletes the DPOF file and unmarks the photos.

Print using the Wizard
The print wizard provides detailed instructions about selecting, sizing, editing, and
printing photographs.

Note Use the wizard to improve photo quality and apply advance effects such
as brightness and color effects.

1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the prompts to print your desired photo or photos.

Print photos from video clips
You can view video clips on the printer screen, and select and print individual frames.
When you first insert a memory card containing a video clip, the printer uses the first
frame of the video clip to represent the clip on the printer screen.
The printer recognizes video clips recorded in these formats:
● Motion-JPEG AVI
● Motion-JPEG QuickTime
● MPEG-1
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The printer ignores video clips in any other format.
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print and press OK.
2. To select your desired photo size, select 4×6 or Enlargement then press OK.
3. Select your desired paper size and press OK.
4. Scroll to select the available videos using the left and right arrows.

Note Videos display a video camera icon in the center of the image.

5. Press the up arrow to play the video.
6. To select a frame to print, press the up arrow to pause the video. The video must

be paused to select frames for printing.
7. Press OK to select the desired frame for printing.
8. Press Print to print the selected frames.

Print a photo index
A photo index shows thumbnail views and index numbers for up to 2000 photos on a
memory card. Use plain paper instead of photo paper to reduce costs.
A photo index may be several pages long.
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print and press OK.
2. Select Print All and press OK.
3. Select 8.5×11 paper.
4. Select the index sheet icon (16 images per page) and press OK.

Stop printing
To stop a print job in progress, press Cancel.

Print photos from a digital camera
You can print photos by connecting a PictBridge digital camera directly to the camera
port of the printer with a USB cable. If you have a digital camera with Bluetooth wireless
technology, you can insert the optional HP Bluetooth® wireless printer adapter in the
printer and send photos to the printer wirelessly.
When you print from a digital camera, the printer uses the settings that you selected on
the camera. For more information, see the documentation that came with the camera.

Digital camera with Bluetooth wireless technology
If you have a digital camera with Bluetooth wireless technology, you can purchase the
optional HP Bluetooth® wireless printer adapter and print from a camera using a Bluetooth
wireless connection.
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Note You can also print from other devices with Bluetooth wireless technology,
such as PDAs and camera phones. For more information, see Connecting to
other devices and the documentation that came with your Bluetooth adapter.

1. Set the Bluetooth options for the printer using the Bluetooth menu on the display.
For more information, see Settings.

2. Load printer paper.
3. Insert the HP Bluetooth® wireless printer adapter into the camera port on the front

of the printer.
The light on the adapter flashes when the adapter is ready to receive data.

4. Follow the instructions in the documentation that came with the digital camera to
send photos to the printer.

Digital camera with PictBridge technology
1. Turn on the PictBridge digital camera and select the photos you want to print.
2. Load paper.
3. Make sure the camera is in PictBridge mode, then connect it to the camera port on

the front of the printer using the USB cable that came with the camera.
Once the printer recognizes the PictBridge camera, the selected photos print
automatically.

Print photos from an iPod
If you have an iPod that can store photos, you can connect your iPod to the printer and
print the photos.

Before you begin
Check that the images you copy to the iPod are in JPEG format.

Note iPods might not be available in your country/region.

To import photos to an iPod
1. Copy photos from a memory card to your iPod using the Belkin Media Reader for

iPod.
2. Verify that photos are on your iPod by selecting Photo Import on the iPod menu.

Photos appear as Rolls.

To print photos from an iPod
1. Connect the iPod to the camera port on the front of the printer using the USB cable

that came with the iPod. The printer screen displays Reading Device for several
minutes while the photos are read. Then the photos appear on the printer screen.

2. Select the photo(s) you want to print and press Print. For more information on
selecting and printing photos, see Printing photos.

Photo layouts
Select the desired print function from the View & Print menu and press OK, choose your
desired print function, then select your desired paper size to select a layout.
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Layout Paper size (photo size)

1 per page borderless 4 x 6 inch (4 x 6 inch)
10 x 15 cm (10 x 15 cm)
5 x 7 inch (5 x 7 inch)
8.5 x 11 inch (8.5 x 11 inch)

1 per page 3.5 x 5 inch (3.25 x 4.75 inch)
4 x 6 inch (3.75 x 5.75 inch)
10 x 15 cm (9.53 x 14.6 cm)
5 x 7 inch (4.75 x 6.75 inch)
8 x 10 inch (7.75 x 9.75 inch)
8.5 x 11 inch (8 x 10 inch)
A6 (9.86 x 14.16 cm)
A4 (20 x 25 cm)
Hagaki (9.36 x 14.16 cm)
L (8.25 x 12.06 cm)

2 per page 3.5 x 5 inch (2.25 x 3.25 inch)
4 x 6 inch (2.75 x 3.75 inch)
5 x 7 inch (3.25 x 4.75 inch)
8 x 10 inch (4.75 x 6.5 inch)
8.5 x 11 inch (5 x 7 inch)
A6 (6.92 x 9.86 cm)
A4 (13 x 18 cm)
Hagaki (6.8 x 9.36 cm)
L (5.87 x 8.25 cm)

3 per page 3.5 x 5 inch (1.5 x 2.25 inch)
4 x 6 inch (1.75 x 2.625 inch)
5 x 7 inch (2.25 x 3.375 inch)
8 x 10 inch (3.33 x 5 inch)
8.5 x 11 inch (4 x 6 inch)
A6 (4.77 x 7.15 cm)
A4 (10 x 15 cm)
Hagaki (4.52 x 6.78 cm)
L (3.96 x 5.94 cm)

4 per page 3.5 x 5 inch (1.5 x 2.25 inch)
4 x 6 inch (1.75 x 2.5 inch)
5 x 7 inch (2.2 x 3.25 inch)
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Layout Paper size (photo size)
8 x 10 inch (3.5 x 4.75 inch)
8.5 x 11 inch (3.5 x 5  inch)
A6 (4.77 x 6.92 cm)
A4 (9 x 13 cm)
Hagaki (4.52 x 6.5 cm)
L (3.96 x 5.7 cm)

9 per page 3.5 x 5 inch (1 x 1.375 inch)
4 x 6 inch (1.125 x 1.5 inch)
5 x 7 inch (1.5 x 2 inch)
8 x 10 inch (2.25 x 3 inch)
8.5 x 11 inch (2.5 x 3.25 inch) – Wallet size
A6 (3.07 x 4.05 cm)
A4 (6.4 x 8.4 cm)
Hagaki (2.9 x 3.86 cm)
L (2.53 x 3.36 cm)

Note The printer may rotate the photos to fit the layout.

Improving photo quality
The printer provides a variety of enhancements that can improve the quality of a photo
printed from a memory card. These print settings do not change the original photo. They
only affect printing.

Adjust photos with poor brightness
1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the onscreen instructions to select your paper size and photo, then press

OK to view the menu.
4. Select Edit Photo and press OK.
5. Select Photo Brightness and press OK.
6. Press  and  to increase or decrease the photo brightness to the desired level,

then press OK.

Remove red eye from photos
The automatic red eye removal feature is enabled when you turn on the Photo fix function.
Enabling the Photo Fix function applies Smart Focus, Adaptive Lighting, and red eye
removal features to selected photos.
➔ Press Photo Fix to enable the Photo Fix function.

Adjust poor-quality video clips
This preference affects photos printed from video clips.
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Improve the quality of photos printed from video clips
1. Select Settings and press OK.
2. Using the arrow keys, find and select Preferences and press OK.
3. Using the arrow keys, find and select Video Enhancement and press OK.
4. Select On, then press OK.
For information about printing photos from video clips, see Print photos from a memory
card.

Getting creative
The printer provides a variety of tools and effects that let you use your photos in creative
ways. These print settings do not change the original photo. They only affect printing.

Add a color effect
You can set the printer to change the color option applied to a photo from Color (default)
to Black & white, Sepia, or Antique.
Photos printed in Sepia print in brown tones and look similar to photos produced in the
early 1900s. Photos printed in Antique print in the same brown tones, but with some
pale colors added to give the appearance that the photos are hand-colored.
1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the onscreen instructions to select your paper size and photo, then press

OK.
4. Select Done Selecting and press OK.
5. Select Edit Photo and press OK.
6. Select Color Effect and press OK.
7. Select the desired color effect and press OK.

Add the date and time to your prints
You can print a stamp on the front of your photos that shows when the photo was taken.
This preference affects all prints.
1. Select Settings and press OK.
2. Using the arrow keys, find and select Preferences and press OK.
3. Select Date Stamp and press OK.
4. Select one of the following date/time stamp options:

– Date and Time
– Date Only
– Off

If you use a computer to modify the photo and then save your changes, the original date
and time information are lost. Changes that you make to the photo using the printer
control panel do not affect the date and time information.

Change the print quality
You can change the print quality for photos. Best quality is the default and produces the
highest quality photos. Normal quality conserves ink and prints faster.
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To change the print quality:
1. Select Settings and press OK.
2. Select Preferences and press OK.
3. Select Print quality and press OK.
4. Select the desired print quality and press OK.
Print quality will revert to Best after the next print job.

Crop a photo
Press Zoom + and Zoom – to increase or decrease the magnification by 1.25×. The
maximum level is 5.0×.
1. Select View & Print and press OK.
2. Select 4×6 or Enlargement to select your desired photo size and press OK.
3. Select the desired paper size and press OK.
4. Select the desired photo and press OK.
5. Press Zoom + to increase the magnification of the photo by 1.25×. The green crop

box appears. Press Zoom + repeatedly until you reach the desired magnification.
(After zooming in, you can zoom back out by pressing Zoom –.)

Note The crop box changes from green to yellow if printing at the selected
magnification will noticeably reduce the print quality.

6. At any magnification level, press the arrows to move the crop box left, right, up, or
down.

7. Press OK when the portion of the image you want to print is in the crop box.
Cropping does not change the original photo. It only affects printing.

Print panoramic photos
1. Select View & Print and press OK.
2. Select Other Projects and press OK.
3. Select Panorama Prints and press OK.
4. Follow the prompt to load 10 x 30 cm (4 x 12 inch) media, then pressOK.
5. Select a photo and press OK. If desired, crop the photo before printing. The crop

box has a 3:1 aspect ratio.

Note All photos printed in panoramic mode are printed borderless.
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4 Getting connected
Use the printer to stay connected to other devices and people.

Connecting to other devices
This printer offers several ways of connecting to computers or other devices. Each
connection type lets you do different things.

Connection type and what you need This lets you...

Memory cards

A memory card

A compatible digital camera memory card
Insert the memory card into the
appropriate memory card slot on the front
of the printer.

● Print directly from a memory card to
the printer.

● Save photos from a memory card
inserted in the printer to a computer
where you can enhance or organize
them in the HP Photosmart Premier
or other software. For more
information, see Saving photos to a
computer and Print photos from a
memory card.

USB
● A Universal Serial Bus (USB) 2.0 full-

speed compliant cable 3 meters (10
feet) or less in length. For instructions
about connecting the printer with a
USB cable, see the Quick Start
booklet.

● A computer with Internet access (to
use HP Photosmart Share).

● Print from a computer to the printer.
See Printing from a computer.

● Save photos from a memory card
inserted in the printer to a computer
where you can enhance or organize
them in the HP Photosmart Premier
or other software.

● Share photos through HP Photosmart
Share.

● Print directly from an HP Photosmart
direct-printing digital camera to the
printer. For more information, see
Print photos from a digital camera and
the camera documentation.

PictBridge

The PictBridge symbol

Print directly from a PictBridge-compatible
digital camera to the printer.
For more information, see Print photos
from a digital camera and the camera
documentation.
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Connection type and what you need This lets you...
A PictBridge-compatible digital camera
and a USB cable.
Connect the camera to the camera port on
the front of the printer.

Bluetooth
The optional HP Bluetooth wireless printer
adapter.
If the printer came with this accessory or
you have purchased it separately, see the
accompanying documentation and the
onscreen Help for instructions.

Print from any device with Bluetooth
wireless technology—such as a digital
camera, a camera phone, or a PDA—to
the printer.
If you connect the optional HP Bluetooth
wireless printer adapter to the printer
through the camera port, be sure to set the
Bluetooth printer menu options as
needed. See Settings.

iPod
An iPod and the USB cable that came with
it. Connect the iPod to the camera port on
the front of the printer.

Print directly from an iPod (with photos
stored in it) to the printer. For more
information, see Print photos from an
iPod.
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Saving photos to a computer
You can save photos to a computer from any memory card inserted in the printer, if you
set up a USB connection between the two devices.

If you are using a Windows computer
Use either of these methods to save photos to your computer.
● Insert a memory card into the printer. The HP Photosmart Premier transfer software

(HP Transfer and Quick Print) opens on your computer screen and allows you to
designate a location on the computer to save images. For more information, see the
onscreen HP Photosmart printer software help.

● Insert a memory card into the printer. The memory card appears in Windows
Explorer as a removable drive. Open the removable drive and drag photos from the
card to any location on your computer.

If you are using a Macintosh
1. Insert a memory card into the printer.
2. Wait for iPhoto to start and read the contents of the memory card.

Note iPhoto starts only if it is set as the default application.

3. Click Import to save the photos on the card to your Macintosh.

Note The memory card also appears on the desktop as a drive icon. You can
open it and drag photos from the card to any location on your Macintosh.

Connecting through HP Photosmart Share
Use HP Photosmart Share to share photos with friends and relatives using e-mail, online
albums, or an online photo finishing service. Your printer must be connected through a
USB cable to a computer with Internet access and have all the HP software installed. If
you try to use Share and do not have all the required software installed or configured, a
message prompts you through the required steps.

Use Share (USB) to send photos (Windows users):
1. Insert a memory card and select some photos.
2. Select Share on the printer screen and press OK.
3. Follow the instructions on your computer to share the selected photos with others.

Use Share (USB) to send photos (Mac users)
1. Open HP Photosmart Studio and select photos to share. For information about

HP Photosmart Studio, see HP Photosmart Premier (Windows users).
2. In the HP Photosmart Studio toolbar, click Share.
3. Click Continue, and follow the instructions on your computer to share the selected

photos with others.
See the onscreen software help for more information about using HP Photosmart Share
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5 Printing from a computer
To print from a computer, the printer software must be installed. During software
installation, either HP Photosmart Premier (Windows Full-install users), HP Photosmart
Essential (Windows Express-install users) or the HP Photosmart Studio (Mac) is installed
on your computer, allowing you to organize, share, edit, and print photos.
For more information on installing the software, see the Quick Start Guide. Update the
software regularly to ensure you have the latest features and improvements; for
instructions, see Update the software.
To work with photos, you need to transfer them to a computer that is connected to the
printer. See Saving photos to a computer.

Note Windows users: HP Photosmart Premier can only be used on computers
with processors that have Intel® Pentium® III (or equivalent) and higher.

Using creative options in the printer software
Read through these tips on how to open and use HP Photosmart Premier, HP Photosmart
Essential, HP Photosmart Studio (Mac), and HP Photosmart Share.

HP Photosmart Premier (Windows users)
HP Photosmart Premier is an easy-to-use software program that gives you everything
you need to have fun with your photos, in addition to basic photo editing and printing.
This software also gives you access to HP Photosmart Share so that you can easily share
your photos.

Open HP Photosmart Premier
➔ Double-click the HP Photosmart Premier icon on your desktop. If you need help,

see the software help within HP Photosmart Premier.
Explore the many features of HP Photosmart Premier:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos in different sizes and in multiple layouts.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments using HP

Photosmart Share, a better way to send e-mail.
● Create — Easily create album pages, cards, calendars, panoramic photos, CD

labels, and more.
● Back-up — Make back-up copies of your photos to store and save.

HP Photosmart Essential (Windows users)
HP Photosmart Essential is an easy-to-use software program that gives you basic photo
editing and printing capabilities. This software also gives you access to HP Photosmart
Share so that you can easily share your photos. HP Photosmart Essential is only
available for Windows users.
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Open HP Photosmart Essential
➔ Double-click the HP Photosmart Essential icon on your desktop. If you need help,

see the software help within HP Photosmart Essential.
Explore the many features of HP Photosmart Essential:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos to make them perfect.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments with HP

Photosmart Share, a better way to send e-mail.

HP Photosmart Studio (Macintosh Users)
➔ Click the HP Photosmart Studio icon in the Dock.
Explore the many features of the HP Photosmart Mac software that is accessible from
the HP Photosmart Studio:
● Import — Import photos or videos from an HP digital camera.
● View and Manage — View, organize, and manage your photos and videos.
● Edit — Adjust and enhance your images.
● Slideshow — Create an online slideshow of your photos.
● Panorama — Create a single panoramic image from several images.
● Create — Create album pages, cards, labels, posters, banners, and more.
● Print — Print your photos and frames from video in standard sizes or in index sheet

format.
● Share — Send photos to family and friends without the bulky attachments.
● Shop — Order online prints and gifts.

HP Photosmart Share
HP Photosmart Share allows you to send photos to family and friends without bulky e-
mail attachments. For more information, see Connecting through HP Photosmart
Share and the HP Photosmart Premier or HP Photosmart Essential help.

Open HP Photosmart Share (Windows users)
➔ Click the HP Photosmart Share tab within HP Photosmart Premier or

HP Photosmart Essential.

Open HP Photosmart Share (Mac users)
➔ Click the Applications tab in HP Photosmart Premier, then double-click HP

Photosmart Share.

Set print preferences
Print preferences are set by default, but can be altered to suit your needs. You can set
specific job settings when you print from the computer. When you change settings before
printing, the changes only affect the current print job. In some Windows software
programs, you need to click Properties or Preferences within the Print dialog box to
access the advanced printing features. See the electronic Help for more information
about printing preferences.
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Access print preferences (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box tabs, or click Properties

or Preferences to access more printing preferences.

Access print preferences (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box by selecting the print options

you want to change in the Copies & Pages drop-down menu.
For more information on changing the printing preferences, see the electronic Help.

Open the electronic help

Windows users:
● Press F1 on your keyboard.
● For field-level help, click the ? in the top right corner of the Print dialog box.

Mac users:
1. From the Finder, choose Help > Mac Help.
2. Choose HP Photosmart Mac Help from the Library menu, and then choose the

printer name in the HP Photosmart Mac Help table of contents.

HP Real Life technologies features
Explore the many photo editing and enhancing options in the HP Real Life technologies
software features. These features—such as automatic red eye removal and adaptive
lighting—make it easy for you to print high-quality photos.
There are three options available:
● The Basic setting sharpens images and improves the quality and clarity of low

resolution images, such as those downloaded from the Internet.
● The Full setting improves images that are under exposed or over exposed, contain

dark areas or red eye, or have colors that appear washed out.
● The Off setting lets you edit the image manually in a software program such as

HP Photosmart software.

Access Real Life technologies features (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Click the Paper/Quality tab, then click the Real Life Digital Photography button

—OR— Click the Properties or Preferences button, and then click the Real Life
Digital Photography button.

Access Real Life technologies features (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Select Real Life Digital Photography from the Copies & Pages drop-down menu.
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6 Care and maintenance
The printer requires very little maintenance. Follow the guidelines in this section to extend
the life span of the printer and printing supplies, and to ensure that the photos you print
are always of the highest quality.
● Clean and maintain the printer
● Update the software
● Store and transport the printer and ink cartridges
● Maintain the quality of photo paper

Clean and maintain the printer
Keep the printer and print cartridge clean and well maintained using the simple
procedures in this section.

Clean the outside of the printer
1. Turn off the printer, then disconnect the power cord from the back of the printer.
2. Wipe the outside of the printer with a soft cloth that has been lightly moistened with

water.

Caution Do not use any type of cleaning solution. Household cleaners and
detergents may damage the printer finish. Do not clean the interior of the printer.
Keep all fluids away from the interior. Do not lubricate the metal rod on which the
print head slides. Noise is normal when the print head moves back and forth.

Aligning the printer
Use the following procedure when the self test report shows streaking or white lines
through any of the blocks of color.
If you still have print quality problems after aligning the printer, try cleaning the print head
using the procedure described in Care and maintenance. If print quality problems persist
after aligning and cleaning, contact HP Support.
1. Load letter or A4 unused plain white paper into the Main tray.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Scroll to find then select Align printer.

The printer aligns the print head, prints an alignment page, and calibrates the printer.
Recycle or discard the alignment page.

5. Press OK.

Print a sample page
You can print a sample page to test the printer photo printing quality and to make sure
the paper is loaded correctly.
1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Select Print sample page and press OK.
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Automatically clean the printhead
If you notice white lines or streaks on the photos you print, or in the color blocks of the
self test report, use this procedure to clean the print head. Do not clean the print head
unnecessarily, as this wastes ink and shortens the life of the ink nozzles on the print
head.
1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Select Clean printhead and press OK.
If print quality still seems poor after you clean the print head, try aligning the printer using
the procedure described in Aligning the printer. If print quality problems persist after
cleaning and aligning, contact HP support.

Manually clean the ink cartridge contacts
Clean the copper-colored ink cartridge contacts if a message appears on the printer
screen that says a cartridge is missing or damaged.
Before cleaning the ink cartridge contacts, remove the ink cartridge and verify that
nothing is covering the ink cartridge contacts or the ink cartridge slot, then reinstall the
ink cartridge. If you continue to get a message that says a cartridge is missing or
damaged, clean the ink cartridge contacts. If you still get this message after cleaning the
contacts, you will need a replacement ink cartridge. Remove the affected ink cartridge
and look at the end-of-warranty date on the bottom, in YYYY/MMM/DD format. If it is
before the end-of-warranty date, contact HP support to obtain a replacement ink
cartridge.

To clean the ink cartridge contacts:
1. Gather the following items to clean the contacts:

– Distilled, filtered, or bottled water (tap water may contain contaminants that can
damage the ink cartridge)

Caution Do not use platen cleaners or alcohol to clean the ink cartridge
contacts. These can damage the ink cartridge or the HP Photosmart
printer printer.

– Dry foam rubber swabs, lint-free cloth, or any soft material that will not come
apart or leave fibers.

2. Open the top cover of the printer.
3. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the

printer, then lift the latch.

Caution Do not remove multiple ink cartridges at the same time. Remove
and clean each ink cartridge one at a time. Do not leave the ink cartridge
outside the printer for more than 30 minutes.

4. Lightly moisten a swab or cloth with water and squeeze out any excess water.
5. Hold the ink cartridge by its handle and gently wipe only the copper-colored contacts

with the swab or cloth.
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1 Gently wipe only the copper-colored contacts
6. Place the ink cartridge back into the empty slot and press down on the gray latch

until it clicks into place.
7. Repeat if necessary for the other ink cartridges.
8. Close the top cover.

Caution The ink supply may become pressurized. Inserting a foreign object into
the ink supply could result in ink being expelled and coming in contact with
persons or property.

Print a self test report
If you are experiencing problems with printing, print a self test report. This two-page report
—labelled the Extended Self Test Diagnostic Page—can help you diagnose printing
problems and can provide valuable information if you need to call HP Support. You can
also use this report to check on the approximate percentage of ink remaining in the ink
cartridges.
1. Select Settings and press OK.
2. Select Tools and press OK, then scroll to Print test page.
3. Select Print test page and press OK.
The HP Photosmart printer prints a two-page self test report that contains the following
information:
● Product information: Includes the model number, serial number, and other product

information.
● Revision information: Includes the firmware version number and indicates whether

or not you have an HP two-sided printing accessory (duplexer) installed.
● Ink delivery system information: Displays the approximate ink level of each

installed ink cartridge, the status of each ink cartridge, the date each cartridge was
installed, and the expiration date for each cartridge.

● Print head assembly information: Contains information that may be used for
diagnostic purposes if you need to call HP Support.

● Print head parameters: Contains information that may be used for diagnostic
purposes if you need to call HP Support.

● Print quality pattern: Displays six color blocks, representing each of the six
installed cartridges. When streaks appear through the color blocks, or there are
missing color blocks, clean the print head using the procedure described in Care
and maintenance. If the color blocks still show print quality problems after cleaning
the print head, align the printer using the procedure described in Aligning the
printer. If the color blocks continue to show print quality problems after cleaning and
aligning, contact HP support.

● History log: Contains information that may be used for diagnostic purposes if you
need to call HP Support.
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Self test report

Update the software
Download the latest printer software update periodically to ensure you have the latest
features and improvements. You can download printer software updates by going to
www.hp.com/support or by using HP Software Update.

Note The printer software update that you download from the HP Web site does
not update the HP Photosmart Premier software.

Downloading the software (Windows)

Note Make sure you are connected to the Internet before you use HP Software
Update.

1. From the Windows Start menu, select Programs (in Windows XP, select All
Programs) > Hewlett-Packard > HP Software Update. The HP Software Update
window opens.

2. Click Check Now. HP Software Update searches the HP Web site for printer
software updates. If the computer does not have the most recent version of the
printer software installed, a software update appears in the HP Software Update
window.

Note If the computer has the most recent version of the printer software
installed, the following message appears in the HP Software Update window:
“No updates are available for your system at this time”.

3. If a software update is available, click the checkbox next to the software update to
select it.

4. Click Install.
5. Follow the onscreen instructions to complete the installation.
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Downloading the software (Mac)

Note Make sure you are connected to the Internet before you use
HP Photosmart Updater.

1. On your Mac in the Finder, choose Go > Applications.
2. Choose Hewlett-Packard > Photosmart > HP Photosmart Updater.
3. Follow the onscreen instructions to check for software updates.

If you are behind a firewall, you need to enter the proxy server information in the
updater.

Store and transport the printer and ink cartridges
Protect the printer and ink cartridges by storing them properly when you are not using
them.

Store and transport the printer
The printer is built to withstand long or short periods of inactivity. Store the printer indoors
out of direct sunlight in a place without temperature extremes.

Caution To prevent ink loss or spillage: do not transport or store the printer on
its side, and leave the ink cartridges installed while storing and transporting the
printer.

Store and transport the ink cartridges
When you transport or store the printer, always leave the active ink cartridge inside the
printer to prevent the ink from drying out.

Caution 1 To prevent ink loss or spillage: leave the ink cartridges installed while
storing and transporting the printer, and avoid leaving used ink cartridge(s) out of
the printer for extended lengths of time.

Caution 2 Make sure the printer completes its power-down cycle before you
unplug the power cord. This allows the printer to store the print head properly.

Follow this tip to help maintain your HP ink cartridges and ensure consistent print quality:
Keep all unused ink cartridges in their original sealed packages until they are needed.
Store ink cartridges at room temperature (15-35 °C or 59-95 °F).

Maintain the quality of photo paper
For best results with photo paper, follow the guidelines in this section.

To store photo paper
● Store the photo paper in its original packaging or in a resealable plastic bag.
● Store the packaged photo paper on a flat, cool, and dry surface.
● Return unused photo paper to the plastic bag. Paper left in the printer or exposed

to the elements may curl.
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To handle photo paper
● Always hold photo paper by the edges to avoid fingerprints.
● If the photo paper has curled edges, place it in its plastic storage bag and gently

bend it in the opposite direction of the curl until the paper lies flat.
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7 Troubleshooting
The HP Photosmart printer is designed to be reliable and easy to use. This chapter
answers frequently asked questions about using the printer and printing without a
computer. It contains information about the following topics:
● Printer hardware problems
● Printing problems
● Error messages
For additional troubleshooting information, see:
● Software installation troubleshooting: The Quick Start guide that came with the

printer.
● Printer software and printing from a computer troubleshooting: The onscreen

HP Photosmart Printer Help. For information about viewing the onscreen
HP Photosmart Printer Help, see Welcome.

Printer hardware problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Note If you want to connect the printer to a computer with a USB cable, HP
recommends using a 2.0 high-speed compliant cable 3 meters (10 feet) or less
in length.

The Print light is flashing blue but the printer is not printing
Solution The printer is busy processing information; wait for it to finish.

The Attention light is on

Solution
● Check the printer screen for instructions. If a digital camera is connected to the

printer, check the camera screen for instructions. If the printer is connected to
a computer, check the computer monitor for instructions.

● Turn off the printer, then unplug its power cord. Wait about 10 seconds, then
plug it in again. Turn on the printer.

If the Attention light stays on after trying the above solutions, go to www.hp.com/
support, or contact HP Support for help.
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The printer does not find the photos I stored on my memory card
Solution The memory card may contain file types the printer cannot read directly
from the card.
● Save the photos to a computer, then print them from the computer. For more

information, see the onscreen HP Photosmart printer help and the
documentation that came with the camera.

● The next time you take photos, set the digital camera to save them in a file
format the printer can read directly from the memory card. For a list of supported
file formats, see Printer specifications. For instructions on setting the digital
camera to save photos in specific file formats, see the documentation that came
with the camera.

The memory card may need to be reformatted if the problem persists.

The printer is plugged in but will not turn on

Solution
● The printer may have drawn too much power. Unplug the printer power cord.

Wait about 10 seconds, then plug the cord back in. Turn on the printer.
● The printer may be plugged into a power strip that is turned off. Turn on the

power strip, then turn on the printer.
● The power cord could be defective. Make sure the green light on the power cord

is lit.

The printer makes noises when I turn it on, or starts making noises after sitting
unused for a while

Solution The printer may make noises after long periods of inactivity
(approximately 2 weeks) or when its power supply has been interrupted and then
restored. This is normal operation. The printer is performing an automatic
maintenance procedure to ensure it produces the best quality output.

All the lights are flashing on the printer
Solution The printer has encountered a hardware error and may need to be
serviced. Unplug the power cord to the printer. Wait about 10 seconds, and then
plug it in again. Turn on the printer. If the lights are still flashing, please go to
www.hp.com/support, or contact HP Support for help.

Printing problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
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The printer does not print borderless photos when I print from the control panel
Solution Make sure the correct layout is selected when setting up the print job.
When selecting photo and paper size, the image rectangle must be solidly filled with
orange to indicate a borderless print.

Printing is very slow
Solution You may have one of the following situations: 1) you may be printing a
PDF or a project containing high-resolution graphics or photos or 2) you may have
selected the highest resolution for your printout. Large, complex projects containing
graphics or photos print slower than text documents, especially at higher resolutions.

Paper does not feed into the printer correctly from the Main tray

Solution
● There may be too much paper loaded in the tray. Remove some paper and try

printing again.
● The Main tray may not be pushed in all the way. Push the Main tray all the way

in.
● The paper guides may not be adjusted correctly. Make sure the paper-width

and paper-length guides fit close to the edges of the paper without bending the
paper.

● Two or more pieces of paper may be sticking together. Remove the paper from
the Main tray, fan the edges of the stack to separate the sheets of paper, then
reload the paper and try printing again.

● If the paper is wrinkled or bent, try using different paper.
● The paper may be too thin or too thick. Use HP inkjet paper for best results. For

more information, see Choose the right paper.

Printed pages are dropping off of the Output tray
Solution Always extend the Output tray extension when you print.

The printout is rippled or curled
Solution The project you are printing uses a larger amount of ink than normal.
Print the project from a computer, and use the printer software to lower the ink
saturation level. See the onscreen HP Photosmart printer help for more information.

The document printed at an angle or is off-center

Solution
● The paper may not be loaded correctly. Reload the paper, making sure it is

correctly oriented in the Main tray and that the paper-width and paper-length
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guides fit close to the edges of the paper. For paper-loading instructions, see
Paper loading tips.

● If you are using a two-sided printing accessory, try removing it, replacing the
rear access door, and printing again.

● The printer may need to be aligned. For more information, see Aligning the
printer.

Colors are not printing satisfactorily

Solution
● One of the color ink cartridges may be empty, resulting in another color being

substituted during printing. Check the estimated ink levels by viewing the ink
level icons from the Tools menu (Settings > Tools > Display Ink Gauge). If an
ink cartridge is empty, replace it. For more information, see Insert ink
cartridges.

● The printer may need to be aligned. For more information, see Aligning the
printer.

● The print head may need to be cleaned. For more information, see Care and
maintenance.

No page came out of the printer or the paper jammed while printing

Solution
● The printer may need attention. Read the printer screen for instructions.
● The power may be off or there may be a loose connection. Make sure the power

is on and the power cord is securely connected.
● You may not have any paper in the Main tray or Photo tray. Check that the paper

is loaded correctly. For paper-loading instructions, see Paper loading tips.
● If the paper jammed while printing, try the following:

– Turn off the printer, then unplug it from the power source. Clear the printer
of any paper obstructing the paper path. Remove the rear access door.
Gently remove the jammed paper from the printer, then replace the rear
access door. If all jammed paper cannot be removed from the rear area of
the printer, try removing paper jammed in the middle of the printer by
opening the paper jam door located inside the top cover. For illustrations
of the two places to clear a paper jam, see Paper errors. When you are
finished clearing the paper jam, plug the printer back in, turn it on, and try
printing again.

– If you were printing labels, make sure a label did not become unglued from
the label sheet while going through the printer.

A blank page came out of the printer

Solution
● You may have begun printing and then cancelled the print job.
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If you cancelled the print job before printing started, the printer may have already
loaded paper in preparation for printing. The next time you print, the printer
ejects the blank page before starting the new printing project.

● A print job with a large amount of data may have been sent to the printer.
Wait for the printer to service the print head before it continues printing.

The printer asked me to print an alignment page
Solution Periodically, the printer needs to perform a print head alignment to
maintain optimal print quality.
When prompted, load plain letter or A4 paper. Discard or recycle the alignment page.

The photo did not print using the default print settings
Solution You may have changed the print settings for the selected photo. Print
settings you apply to an individual photo override the default print settings. Discard
all print settings that have been applied to an individual photo by deselecting the
photo. For more information, see Settings.

The printer ejects the paper when preparing to print
Solution Direct sunlight could be interfering with the operation of the automatic
paper sensor. Move the printer out of direct sunlight.

Print quality is poor

Solution
● One of the ink cartridges may be very low on ink, resulting in another color being

substituted during printing. Check the estimated ink levels by viewing the ink
level icons from the Tools menu (Settings > Tools > Display Ink Gauge). If an
ink cartridge is low on ink, replace it. For more information, see Insert ink
cartridges.

● Use photo paper designed for the printer. For best results, use the papers
recommended in Choose the right paper.

● You may be printing on the wrong side of the paper. Make sure the paper is
loaded with the side to be printed facing down.

● You may have selected a low-resolution setting on the digital camera. Reduce
the size of the image and try printing again. For better results in the future, set
the digital camera to a higher photo resolution.

● There may be a problem with an ink cartridge or with the print head. Try the
following:
– Remove and then reinsert each ink cartridge, one at a time, to make sure

they are all properly seated.
– Run the automatic print head cleaning procedure. For more information,

see Care and maintenance.
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– Align the printer. For more information, see Aligning the printer.
– If print quality problems persist after you have tried all of the above

solutions, contact HP Support.

Photos are not printing correctly

Solution
● You may have loaded the photo paper incorrectly. Load the photo paper with

the side to be printed facing down.
● The photo paper may not have fed into the printer correctly. Try the following:

– Check for a paper jam. For more information, see Paper errors.
– Insert the photo paper as far as it will go into the Photo tray.
– Load one sheet of photo paper at a time.

The photos I marked for printing in the digital camera do not print
Solution Some digital cameras let you mark photos for printing in both the
camera's internal memory and on the memory card. If you mark photos in the internal
memory, and then move photos from the camera's internal memory to the memory
card, the marks do not transfer. Mark photos for printing after you transfer them from
the digital camera's internal memory to the memory card.

Error messages
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
Error messages that appear on the printer screen can be divided into the following types:
● Paper errors
● Ink cartridge errors
● Memory card errors
● Computer printing errors

Paper errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Paper jam. Clear jam then press OK.
Solution Turn off the printer, then unplug it from the power source. Clear the
printer of any paper that may be obstructing the paper path. Remove the rear access
door. Gently remove the jammed paper from the printer, then replace the rear access
door.
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1 Remove the rear access door to clear paper jams.

If you cannot remove all jammed paper from the rear area of the printer, try removing
paper jammed in the middle of the printer by opening the paper jam door located
inside the top cover.

1 Open the paper jam door to clear paper jams in the middle of the printer.

Plug the printer back in and turn it on.

Error message: Out of paper. Load paper then press OK.
Solution Load paper, then press OK to print again. For paper-loading instructions,
see Paper loading tips.

Error message: Unsupported media size.
Solution The printer cannot use the size of paper loaded in the paper tray.
Press OK, then load a supported paper size instead. For a list of supported paper
sizes, see Printer specifications.

Error message: Automatic paper sensor failed.
Solution The automatic paper sensor is obstructed or damaged. Try moving the
printer out of direct sunlight, then press OK and try printing again. If this does not
work, go to www.hp.com/support or contact HP Support.
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Ink cartridge errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Wrong ink cartridge(s) installed
Solution The first time you set up and use your HP Photosmart printer printer,
make sure to install the ink cartridges that were shipped with your printer. The ink
in these ink cartridges is specially formulated to mix with the ink in the print head
assembly.
To resolve this error, replace the affected ink cartridge(s) with the ink cartridges that
were shipped with your HP Photosmart printer printer.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Incorrect ink cartridge
Solution The indicated ink cartridge(s) cannot be used after the device has
undergone initialization. Replace the ink cartridge(s) with the appropriate ink
cartridges for your HP Photosmart printer. The cartridge numbers you can use with
this printer appear on the back cover of this printed guide.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Replace cartridges soon
Solution The indicated ink cartridge(s) are empty.
You might be able to continue printing for a short period of time with ink remaining
in the print head assembly. Replace the indicated ink cartridge(s) or press OK to
continue.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink cartridge(s) are empty
Solution The indicated ink cartridge(s) are empty and there is not enough ink in
the printhead reservoir for normal printing and servicing tasks. Replace the indicated
ink cartridge(s) with new ink cartridge(s).
● If the black ink cartridge is empty, you can continue printing with the other color

ink cartridges by selecting that option in the displayed printer screen prompts.
● If a color ink cartridge is empty, you can continue printing with the black ink

cartridge by selecting that option in the displayed printer screen prompts.
Depending on the status of your print job, you can press OK to continue. If the HP
Photosmart printer is in the middle of a print job, press Cancel and restart your print
job.

Note Text and photo quality will differ from those printed when using all ink
cartridges. If the empty ink cartridge(s) are not replaced soon, all printing will
stop.
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For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Cannot print
Solution The indicated ink cartridge(s) are out of ink.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
The HP Photosmart printer cannot continue printing until the indicated ink cartridge
(s) are replaced. All printing will stop.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink cartridge problem
Solution The indicated ink cartridge(s) are missing or damaged.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
If there are no ink cartridges missing from the HP Photosmart printer, the ink
cartridge contacts might need to be cleaned.
For more information on replacing ink cartridges, see Insert ink cartridges. For more
information on cleaning the ink cartridge contacts, see Care and maintenance.
If there are no ink cartridges missing from the HP Photosmart printer, and you still
receive this message after cleaning the ink cartridge contacts, you will need a
replacement ink cartridge. Remove the affected ink cartridge and look at the end-
of-warranty date on the bottom, in YYYY/MMM/DD format. If it is before the end-of-
warranty date, contact HP Support to obtain a replacement ink cartridge.

Error message: Ink Expiration Nearly Expired. —OR— Ink Cartridge(s) Expired.
Solution Each ink cartridge has an expiration date. The purpose of expiration is
to protect the printing system and to ensure ink quality. When you receive an ink
expiration message, remove and replace the ink cartridge, and then close the
message. You can also continue printing without replacing the ink cartridge, by
following the instructions on your computer screen. HP recommends replacing the
expired ink cartridges. HP cannot guarantee the quality or reliability of expired ink
cartridges. Device service or repairs required as a result of using expired ink will not
be covered under warranty.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Non-HP ink
Solution Replace the indicated ink cartridge(s) or press OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.
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If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: Original HP ink depleted
Solution Replace the indicated ink cartridge(s) or press OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: Scheduled maintenance
Solution You must align the printer to ensure excellent print quality. With letter or
A4 unused plain white paper in the Main tray, press OK. The HP Photosmart printer
aligns the print head, calibrates the printer, and then prints a test page. Recycle or
discard the test page.

Error message: Calibration error

Solution
● If you have color or photo paper loaded in the Main tray when you align the

printer, the alignment might fail. Load unused plain white letter or A4 paper into
the Main tray, and then try the alignment again. If the alignment fails again, you
might have a defective sensor or ink cartridge; contact HP Support.

● The ink cartridge or sensor is defective. Contact HP support.

Error message: Print cartridge cradle is stuck
Solution Remove any objects that are blocking the print head assembly.

To clear the print head assembly
1. Open the top cover, then open the paper jam door.
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1 Open the paper jam door to clear the print head assembly.
2. Remove any objects that are blocking the print head assembly, including paper

and any packing materials.
3. Turn the printer off, then turn it on again.
4. Close the paper jam door and the top cover.

Error message: Ink System Failure
Solution The print head assembly or the ink delivery system has failed and the
HP Photosmart printer can no longer print.
Turn off the printer, then unplug its power cord. Wait about 10 seconds, then plug it
in again. If this does not clear the error message, please contact HP Support.

Memory card errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Photo is missing. —OR— Some photos are missing.
Solution The printer cannot read the file on the memory card, or one or more files
specified for the job are missing from the memory card. Try saving the photos to the
computer using the digital camera rather than the memory card. If a photo is missing,
you may have accidentally deleted the photo from the card.
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Error message: Card access error. Job was cancelled. Press OK.—OR— File
directory structure is corrupted. —OR— Card may be damaged. Job was
cancelled. Press OK.

Solution The printer cannot read the data on the memory card and cannot
complete any current print jobs. The data may be corrupted or there may be a
physical problem with the memory card.
● Save the files to the computer and access them from there.
● If this does not work, use a new memory card or reformat the memory card

using the digital camera. Any photos on the memory card will be lost.
● If this does not work, the photo files may be damaged or unreadable. Before

you contact HP Support, try another memory card to determine if it is the printer
or the memory card that is failing.

Error message: Cannot print photos.
Solution More than 10 photos specified for a print job may be corrupted, missing,
or are an unsupported file type. For information about supported file types, see
Printer specifications.
● Save the photos to the computer using the digital camera rather than the

memory card.
● Save the files to the computer and print from the computer.
● Print a photo index and reselect photos. For more information, see Printing

photos.

Error message: Card is password protected. Cannot access card.
Solution The printer cannot read the memory card because the card is password-
protected. Follow these steps:
1. Remove the memory card from the printer.
2. Insert the memory card in the device you originally used to store the password

on the memory card.
3. Remove the password from the memory card.
4. Remove the memory card and reinsert it in the printer memory card slot.
5. Try printing again.

Error message: Card is locked. Cannot access card.
Solution Make sure the lock switch on the card is in the unlocked position.

Error message: Card is not fully inserted. Push card in a little more.
Solution The printer can detect the memory card but cannot read it. Push the
memory card gently into the memory card slot until it stops. For more information,
see Insert memory cards.
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Error message: Use only one (1) card at a time. Please remove a memory card. —
OR— Use only one (1) device at a time. Please remove/disconnect a device.

Solution The printer has two or more different types of memory cards inserted
simultaneously, or a memory card is inserted and a digital camera is connected to
the camera port at the same time. Remove memory cards or disconnect the camera
until only one card is in the printer or only a camera is connected.

Error message: Card was removed. Job was cancelled. Press OK.
Solution You removed a memory card from the printer while it was busy printing
a file from the card. Follow these steps:
1. Press OK.
2. Reinsert the memory card and print the selected photos again. The memory

card must remain inserted until the print job is complete.
To avoid damage to memory cards in the future, do not remove them from the printer
memory card slot while they are being accessed. For more information, see
Removing a memory card.

Error message: Camera selections (DPOF) file has error.
Solution The printer is unable to read a DPOF file due to corrupted data or an
error on the memory card. Use the printer control panel to reselect the photos. For
more information, see Print photos from a memory card.

Error message: Some camera-selected photos are not on card.
Solution Some camera-selected photos are missing or have been deleted. Try
the following:
● Confirm that you did not accidentally delete the photo from the memory card.
● Reselect the photos again using the digital camera.
● Print a new photo index to see the index numbers associated with each photo.

For more information, see Printing photos.

Error message: Cannot display this photo. —OR— Cannot display all photos. —
OR— Photos are corrupted.

Solution The memory card contains image formats the printer does not support,
or the files are corrupted. For a list of supported image formats, see Printer
specifications. Access photos using the computer. For information about accessing
photos through the computer, see Printing from a computer.

Error message: Unsupported card type.
Solution Use your camera to transfer the photos to your computer, and then print
from your computer.
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Error message: Some photo numbers are not on card.
Solution Use your camera to transfer the photos to your computer, and then print
from your computer. If some photos are still missing, they may have been deleted
from the memory card.

Computer and connectivity printing errors
Before contacting HP Support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Printer memory is full. Job was cancelled. Press OK.
Solution The printer encountered a problem when printing photos. Try the
following:
● To clear the printer memory, turn the printer off, then turn it on again.
● Print fewer photos at a time.
● Save the photos to the computer and print from there.
● Save the files to the computer using a memory card reader and then print from

the computer.

Error message: Communication error. Check computer connection. Press OK. —
OR— Data was not received. Check computer connection. Press OK to continue.
—OR— No response from computer.

Solution The printer cannot communicate properly with the computer. The printer
software may not be working or a cable may be loose. Make sure the USB cable is
securely attached to both the computer and to the USB port on the back of the printer.
If the cable is secure, verify that the printer software is installed.

Error message: Camera disconnected during print job.
Solution The print job will be cancelled. Reattach the USB cable to the camera
and printer and resend the print job.
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8 HP support
Support process

If you have a problem, follow these steps:
1. Check the documentation that came with the HP Photosmart printer.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is

available to all HP customers. It is the fastest source for up-to-date device
information and expert assistance and includes the following features:
– Fast access to qualified online support specialists
– Software and driver updates for the HP Photosmart printer
– Valuable HP Photosmart printer and troubleshooting information for common

problems
– Proactive device updates, support alerts, and HP newsgrams that are available

when you register the HP Photosmart printer
3. For Europe only: Contact your local point of purchase. If the HP Photosmart printer

has a hardware failure, you will be asked to bring it back to your local point of
purchase. (Service is provided at no charge during the device limited warranty
period. After the warranty period, you will be quoted a service charge.)

4. Call HP support. Support options and availability vary by device, country/region, and
language.

HP support by phone
For a list of support phone numbers, see the phone number list on the inside of the front
cover.

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America
(including Mexico). To determine the duration of phone support in Europe, the Middle
East, and Africa, go to www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the HP Photosmart printer.
Be prepared to provide the following information:
● Device model number (located on the label on the front of the device)
● Device serial number (located on the back or bottom of the device)
● Messages that appear when the situation occurs
● Answers to these questions:

– Has this situation happened before?
– Can you re-create it?
– Did you add any new hardware or software to your computer at about the time

that this situation began?
– Did anything else occur prior to this situation (such as a thunderstorm, device

was moved, etc.)?
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After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may
also be available at the HP online support Web site: www.hp.com/support. Contact your
HP dealer or call the support phone number for your country/region to learn more about
support options.
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A Specifications
This section lists the minimum system requirements for installation of the HP Photosmart printer
software, and provides selected printer specifications.
For a complete list of printer specifications and system requirements, see the onscreen
HP Photosmart Printer Help. For information about viewing the onscreen HP Photosmart printer
help, see Welcome.

System requirements

Component Windows PC minimum Macintosh minimum

Operating system Microsoft® Windows 98, 2000
Professional, Me, XP Home,
and XP Professional

Mac® OS X 10.3, 10.4, and
later

Processor Intel® Pentium® II (or
equivalent) and higher

G3, G4, G5 or Intel Core Duo
or greater

RAM 64 MB (128 MB
recommended)

Mac OS X 10.3, 10.4, and
later: 128 MB

Free disk space 500 MB 150 MB

Video display 800 x 600, 16-bit or higher 800 x 600, 16-bit or higher

CD-ROM drive 4x 4x

Connectivity USB: Microsoft Windows 98,
2000 Professional, Me, XP
Home, and XP Professional
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

USB: Front and back ports
(Mac OS X 10.3, 10.4, and
later)
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

Browser Microsoft Internet Explorer 5.5
or later

—

Printer specifications

Category Specifications

Connectivity USB: Microsoft Windows 98, 2000 Professional, Me, XP
Home, and XP Professional; Mac OS X 10.3, 10.4, and later

Image file formats JPEG Baseline
TIFF 24-bit RGB uncompressed interleaved
TIFF 24-bit YCbCr uncompressed interleaved
TIFF 24-bit RGB packbits interleaved
TIFF 8-bit gray uncompressed/packbits
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Category Specifications
TIFF 8-bit palette color uncompressed/packbits
TIFF 1-bit uncompressed/packbits/1D Huffman

Video file formats Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

Media specifications Recommended maximum length: 61 cm (24 inch)
Recommended maximum paper thickness: 292 µm (11.5
mil)
Recommended maximum envelope thickness: 673 µm
(26.5 mil)

Media sizes supported Supported sizes when printing from a computer
7.6 x 12.7 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Supported sizes when printing from the control panel
Metric: A6, A4, 10 x 15 cm (with and without tab); Imperial:
3.5 x 5 inch, 4 x 6 inch (with and without tab), 4 x 12 inch,
5 x 7 inch, 8 x 10 inch, 8.5 x 11 inch; Other: Hagaki and L-
size

Media types supported Paper (plain, inkjet, photo, and panoramic photo)
Envelopes
Transparencies
Labels
Cards: index, greeting, Hagaki, A6, L-size
Iron-on transfers
Avery C6611 and C6612 photo sticker paper: 10 x 15 cm
(4 x 6 inch), 16 rectangular or oval stickers per page

Memory cards CompactFlash Type I and II
Microdrive
MultiMediaCard
Secure Digital
Memory Sticks
xD-Picture Card

Memory card-supported file
formats

Printing: See Image file formats earlier in this table.
Saving: All file formats

Paper tray – media sizes
supported

Main tray
8 x 13 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Photo tray
Up to 10 x 15 cm (4 x 6 inch), with or without tab
Output tray
All supported Main tray and Photo tray sizes

Paper tray capacity Main tray
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Category Specifications
100 sheets of plain paper
14 envelopes
20–40 cards (depending on thickness)
30 sheets of labels
25 transparencies, iron-on transfers, or photo paper
10 sheets of photo paper
Photo tray
Output tray
20 sheets of photo paper
50 sheets of plain paper
10 cards or envelopes
25 sheets of labels or iron-on transfers

Operating environment Recommended temperature range: 15–30 °C (59-86 °F)
Maximum temperature range: 5–40 °C (41-104 °F)
Storage temperature range: -40–60 °C (-40-140 °F)
Recommended humidity range: 20–80% RH
Maximum humidity range: 10–80% RH

Physical specifications Height: 17.9 cm (6.8 inch).
Width: 46.25 cm (18.2 inch)
Depth: 38.7 cm (15.25 inch)
Weight: 7.7 kg (17.0 lb).

Power consumption Printing, Average: 75 W
Printing, Maximum: 94 W
Idle: 13.3–16.6 W

Power supply model number HP Part # 0957-2105

Power requirement 100–240 VAC (± 10%), 50–60 Hz (± 3 Hz)

Ink cartridges HP Yellow Ink Cartridge
HP Cyan Ink Cartridge
HP Light Cyan Ink Cartridge
HP Magenta Ink Cartridge
HP Light Magenta Ink Cartridge
HP Black Ink Cartridge

Note The cartridge numbers you can use with this
printer appear on the back cover of this printed
guide. If you have already used the printer several
times, you can also find the cartridge numbers in
the printer software. For more information, see
Insert ink cartridges.

Print speed (maximum) Black printouts: 32 pages per minute
Color printouts: 31 pages per minute

(continued)
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Category Specifications
Photos: 14 seconds for each 10 x 15 cm (4 x 6 inch) photo

USB support Microsoft Windows 98, 2000 Professional, Me, XP Home,
and XP Professional
Mac OS X 10.3, 10.4, and later
HP recommends using a USB 2.0 full-speed compliant
cable 3 meters (10 feet) or less in length.
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B HP Warranty
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A. Extent of limited warranty
  1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from 

defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase 
by the customer.

  2. For software products, HP's limited warranty applies only to a failure to execute programming instructions. HP does 
not warrant that the operation of any product will be interrupted or error free.

  3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover 
any other problems, including those that arise as a result of:

   a. Improper maintenance or modification;
   b. Software, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications;
   d. Unauthorized modification or misuse.
  4. For HP printer products, the use of a non-HP cartridge or a refilled cartridge does not affect either the warranty to the 

customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use 
of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for 
the particular failure or damage.

  5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's 
warranty, HP shall either repair or replace the product, at HP's option.

  6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, 
within a reasonable time after being notified of the defect, refund the purchase price for the product.

  7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
  8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the 

product being replaced.
  9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.
  10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. Contracts 

for additional warranty services, such as on-site service, may be available from any authorized HP service facility in 
countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE.

C. Limitations of liability
  1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and 

exclusive remedies.
  2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN 

THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF 

   SUCH DAMAGES.
D.  Local law
  1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary 

from state to state in the United States, from province to province in Canada, and from country to country elsewhere 
in the world.

  2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed 
modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this W
Statement may not apply to the customer. For example, some states in the United States, as well as some 
governments outside the United States (including provinces in Canada), may:

   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer 
    (e.g., the United Kingdom);
   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer 

cannot disclaim, or allow limitations on the duration of implied warranties.
 3.  THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT

EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.

HP product Duration of limited warranty
Software Media 90 days
Printer 1 year
Print or Ink cartridges  Until the HP ink is depleted or the “end of warranty” date printed 
 on the cartridge has been reached, whichever occurs first. This 

warranty does not cover HP ink products that have been refilled, 
remanufactured, refurbished, misused, or tampered with.

Accessories 90 days
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Index

A
accessories 11
accessories, two-sided

printing 11
after the support period 60
aligning the printer 39
alignment page 39
alignment, required 54
antique coloration 29

B
Bluetooth

connecting to printer 23,
31

menu settings 11
wireless printer adapter

11
borderless prints 29
buttons 10

C
calling HP support 59
cameras

connecting to printer 23,
31

direct-printing 25
PictBridge 25
port 8
printing from 25

care and maintenance 39
cartridges. See ink cartridges
cleaning

copper-colored contacts
40

print head 40
printer 39

color effects 29
CompactFlash 20
computer

connecting to printer 31
printing from 35
saving photos to 33
system requirements 61

control panel 10

D
damaged, ink cartridge 53

date and time stamps 29
digital cameras. See cameras
Digital Print Order Format 24
documentation, printer 7
DPOF 24

E
e-mailing photos 33
energy consumption 2
Energy Star 2
error messages 50

F
file formats, supported 20, 61
Frequently asked questions

45

G
Getting help 45

H
Help 45
Hewlett-Packard Company

notices 2
home, screen 11
HP direct-printing digital

cameras 25
HP Instant Share 31
HP Photosmart Essential 35
HP Photosmart Premier 35
HP Photosmart Share 33, 36
HP Photosmart Studio (Mac

only) 36
HP Software Update 42

I
ink

checking level 41
empty 52
replace soon 52

ink cartridges
damaged 53
empty 52
expired 53
HP ink depleted 54
incorrect 52
ink level, checking 19

inserting 19
missing 53
non-HP ink 53
printer alignment 54
replace soon 52
replacing 19
storing 43
testing 41

ink level, checking 19
inserting

ink cartridges 19
memory cards 21

iPod 32

J
JPEG file formats 20

L
layout and photo size 26
lights 10
Load paper 15

M
Macintosh

HP Photosmart Mac
software 36

memory cards
inserting 21
printing from 23
removing 22
saving photos to a

computer 33
supported types 20

Memory Sticks 20
Microdrive 20
missing ink cartridge 53
MPEG-1 file format 20
MultiMediaCard 20

P
Paper

load 15
paper

buying and choosing 15
maintaining 15, 43
specifications 61
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trays 8
phone support 59
phone support period

period for support 59
photos

antique coloration 29
cropping 29
date and time stamp 29
e-mailing 33
framing 29
improving quality 28
printing 23
saving to computer 31
sepia tones 29
supported file formats 20
zooming 29

Photosmart Share. See
HP Photosmart Share

PictBridge cameras 25
placing a call 59
print head

cleaning 40
failure 55
stalled 54

print quality
changing 23

Printer
Specifications 61

printer
accessories 11
care and maintenance 39
cleaning 39
connecting 23, 31
documentation 7
error messages 50
home 11
parts 8
specifications 61
storing 43

printer software
updating 42

printer software, updating 35
printing

from a computer 35
from BlueTooth device 23
from cameras 25
from memory cards 23
from PictBridge camera

23
photos 23
range of photos 23
test page 41
without computer 23

Q
quality

photo paper 43
photos 28
printing test page 41

Questions and Answers 45

R
range

printing 23
regulatory notices

regulatory model
identification number 2

removing memory cards 22
replacing ink cartridges 19

S
saving photos to computer 31
Secure Digital 20
sepia tones 29
Sony Memory Sticks. See

Memory Sticks
Specifications 61
storing

ink cartridges 43
photo paper 43
printer 43

support 59
support process 59
system requirements 61

T
test page 41
TIFF file format 20
transporting printer 11
trays, paper 8
Troubleshooting 45
troubleshooting

error messages 50
two-sided printing 11

U
USB

connection type 31
port 8
specifications 61

V
video clip

supported file formats 20

X
xD-Picture Card 20
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